
ISBN: 978-975-11-6885-6

11
DERS

MATERYALİ

MESLEKİ VE TEKNİK ANADOLU LİSESİ

GRAFİK VE FOTOĞRAF ALANI

YAYIN GRAFİĞİ





Eda ZİNCİR
Eylem KAYGUSUZ

Gonca KILINÇ
Hümeyra OĞUZ
Nedim KEŞKÜŞ

Yazarlar

DERS
MATERYALİ

MESLEKİ VE TEKNİK ANADOLU LİSESİ

GRAFİK VE FOTOĞRAF ALANI

YAYIN GRAFİĞİ
11



Hazırlayanlar

Dil Uzmanı
Yıldız DOĞAN

Program Geliştirme Uzmanı
Dr. Eda ÖZ

Ölçme ve Değerlendirme Uzmanı
Tülay ENGİN

Rehberlik Uzmanı
Sema ARSLAN

Görsel Tasarım Uzmanı
Mehtap ONUR

MİLLÎ EĞİTİM BAKANLIĞI YAYINLARI .......................................................................
YARDIMCI VE KAYNAK KİTAPLAR DİZİSİ .................................................................

Millî Eğitim Bakanlığının 24.12.2020 gün ve 18433886 sayılı oluru ile Meslekî 
ve Teknik Eğitim Genel Müdürlüğünce ders materyali olarak hazırlanmıştır.

ISBN: 978-975-11-6885-6

Her hakkı saklıdır ve Millî Eğitim Bakanlığına aittir. Ders materyalinin metin, soru şekil-
leri kısmen de olsa hiçbir surette alınıp yayımlanamaz.











9 yayın grafiği

İÇİNDEKİLER

DERGİ TASARIMI1. Öğrenme Birimi

DERS MATERYALİNİN TANITIMI ..................................................... 12
1.1. DERGİ TASARIMI VE ÖZELLİKLERİ ......................................	16
       1.1.1. Derginin Tanımı, Çeşitleri ve Özellikleri ..........................	17
                 1. ETKİNLİK ...................................................................	18
       1.1.2. Dergi Ölçüsü ve Önemi ...................................................	18
       1.1.3. Dergide Mizanpaj Kuralları ..............................................	18
       1.1.4. Dergi Tasarımında Bölüm ve Şablon Oluşturma .............	20
       1.1.5. Dergi Tasarım Eskizi Oluşturma ......................................	21
                 1. UYGULAMA ...............................................................	22
1.2. MİZANPAJ PROGRAMINDA DERGİ TASARIMI .....................	23
       1.2.1. Mizanpaj Programının Genel Anlatımı ............................	23
                 2. ETKİNLİK ...................................................................	24
                 3. ETKİNLİK ...................................................................	30
       1.2.2. Mizanpaj Programında Uygun Formatta Kaydetmek ...	38
                 2. UYGULAMA ...............................................................	41
1.3. DERGİ KAPAĞI TASARIMI ......................................................	42
       1.3.1. Dergi Kapağının Önemi ve Özellikleri .............................	42
       1.3.2. Dergi Kapağında Kullanılacak Tasarım Elemanlarının 	                       
                 Düzenlenmesi .................................................................	43
       1.3.3. Dergi Kapağı Kayıt Seçenekleri, Baskı ve Yayın ............	45
                 3. UYGULAMA ...............................................................	46
                 ÖLÇME VE DEĞERLENDİRME ....................................	47

İÇİNDEKİLER



10yayın grafiği

İÇİ
ND

EK
İLE

R

GAZETE TASARIMI2. Öğrenme Birimi

2.1. GAZETENİN İÇ VE ARKA SAYFA TASARIMI ................................... 	50
       2.1.1. Gazete Mizanpajı ......................................................................	50
                 1. ETKİNLİK .............................................................................	55
                 2. ETKİNLİK .............................................................................	55
                 1.UYGULAMA ..........................................................................	56
       2.1.2. Ekonomi Sayfası .......................................................................	57

3. ETKİNLİK .............................................................................	58
4. ETKİNLİK .............................................................................	58
2. UYGULAMA .........................................................................	59

2.1.3. Kültür Sanat Sayfası .................................................................	60
5. ETKİNLİK .............................................................................	61
6. ETKİNLİK .............................................................................	61
3. UYGULAMA .........................................................................	62

       2.1.4. Spor ve Magazin Sayfaları ........................................................	63
7. ETKİNLİK .............................................................................	64
8. ETKİNLİK .............................................................................	64
4. UYGULAMA .........................................................................	65
5. UYGULAMA .........................................................................	66

       2.1.5. Arka Sayfa ................................................................................	67
10. ETKİNLİK ...........................................................................	68
11. ETKİNLİK ...........................................................................	68
6. UYGULAMA .........................................................................	69

       2.1.6. İlan ve Reklam Sayfaları ...........................................................	70
12. ETKİNLİK ...........................................................................	71
13. ETKİNLİK ...........................................................................	71
7. UYGULAMA .........................................................................	72



11 yayın grafiği

İÇİNDEKİLER

2.2. GAZETEDE BİRİNCİ (ÖN) SAYFA TASARIMI .................................. 	73
       14. ETKİNLİK ....................................................................................	 74
             2.2.1. Birinci Sayfa Tasarımında Manşetin Önemi .........................74
             2.2.2. Birinci Sayfa Taslak Planı Hazırlama ...................................75
                 15. ETKİNLİK ...........................................................................	77
                 16. ETKİNLİK ...........................................................................	77
       2.2.3. Hazırlanan Birinci Sayfa Şablonuna Metin, Görsel ve     						 
                 Manşetlerin Taslak Plana Uygun Yerleştirilmesi ....................	78
                 8. UYGULAMA .........................................................................	79
                 ÖLÇME VE DEĞERLENDİRME ..............................................	80
                 EK 1 .......................................................................................... 81
                 CEVAP ANAHTARI .................................................................. 82
                 KAYNAKÇA ............................................................................. 82



12yayın grafiği

DER
S M

ATE
RYA

LİN
İN 

TAN
ITI

MI

Bu öğrenme biriminde 
neler öğrenileceğini 

gösterir.

Konu başlığını 
gösterir.

Öğrenme birimi kareko-
dunu gösterir.

Hazırlık çalışmaları 
alanını gösterir.

Öğrenme biriminin 
adını gösterir.

Konu anlatımını 
gösterir.

Öğrenme biriminde yer 
alan konuları gösterir.

Öğrenme biriminin 
adını gösterir.

Öğrenme biriminin giriş 
kapağını adını gösterir.

Öğrenme biriminin
numarasını gösterir.

Öğrenme biriminde yer 
temel kavramları

gösterir.
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DERS MATERYALİNİN TANITIMI
Uygulama alanını 

gösterir.
Etkinlik alanını 

gösterir.

Ölçme ve değerlendirme 
alanını gösterir.

Bu ders materyalinde ölçü birimlerinin uluslararası kısaltmaları kullanılmıştır.



Öğrenme 
Birimi

DERGİ 
TASARIMI
DERGİ 
TASARIMI1.1.



KONULAR
1.1. DERGİ TASARIMI VE ÖZELLİKLERİ
1.2. MİZANPAJ PROGRAMINDA DERGİ 		
       TASARIMI
1.3. DERGİ KAPAĞI TASARIMI

TEMEL KAVRAMLAR
•	 dergi
•	 mizanpaj
•	 şablonlar
•	 stiller
•	 tablolar
•	 baskı
•	 yayın

NELER ÖĞRENECEKSİNİZ?
•	 Derginin mizanpaj kuralları
•	 Dergiyi bölümlere ayırma, derginin her sayfasında farklı şab-

lon oluşturma ve kenar boşlukları
•	 Dergi bölümleri için elde taslak çalışma
•	 Dergi mizanpajında metin kuralları
•	 Mizanpaj programında paragraf, karakter stilleri
•	 Mizanpaj programında madde ve numaralandırma
•	 Dergi tasarımında nesnelerin önemi
•	 Dergide kullanılacak görselleri boyutlandırma 
•	 Derginin içindekiler bölümü
•	 Künye hazırlama ve şablonla çalışma
•	 Dergi tasarımını uygun formatta kaydetme
•	 Dergi kapağının özellikleri
•	 Dergi kapağı taslağı hazırlama
•	 Mizanpaj programında dergi kapağı hazırlama
•	 Dergi kapağında haber başlıkları, font, logo ve barkot kulla-

nımı

Hazırlık Çalışmaları
1.	 “Basım ve yayın teknolojisi” hakkında neler biliyorsunuz? Sı-

nıf arkadaşlarınızla paylaşınız.
2.	 “Süreli yayın” kelime grubu sizin için ne ifade ediyor? Açık-

layınız.
3.	 Dergi sayfalarında dikkatinizi çekenleri söyleyiniz.
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1.1. DERGİ TASARIMI VE ÖZELLİKLERİ
Bilim nedeniyle teknolojinin hızlı ve olağan gelişiminden en çok etkilenen sektörle-
rin başında basım ve yayın sektörü gelmektedir. Özellikle basım öncesi işlemler-
de yirmi beş sene öncesine kadar kullanılan yöntemlerin birçoğunun yerini dijital 
yöntemler almıştır. Tasarım uygulaması amacıyla kullanılan birçok araç ve fiziki 
alanlar yerine günümüzde “masaüstü yayıncılık sistemleri” kullanılır hâle gelmiştir. 

Görsel 1.1: Dergi sayfası

Tarayıcı, yazılım, yazıcı vb. tamamlayıcı sistemler ve bilgisayar ile çoğaltılması, 
yayımlanması amaçlanan grafik ürünlerinin tasarlanarak baskı ve yayıma hazır 
hâle getirilmesi sistemine masaüstü yayıncılık denir. Masaüstü yayıncılıktaki 
grafik ürünlerine çoklu sayfadan oluşan bütün grafik ürünleri dâhil edilebilir. Bun-
ların içinde ilk sıralarda dergi, gazete ve kitap yer alır (Görsel 1.1).

Teknolojik gelişmeler ve dolayısıyla yaşam şartlarındaki değişme ve gelişme, gra-
fik ürünlerinin basım ve multimedya olmak üzere iki farklı türe ayrılmasını gerekli 
kılmıştır. Firmalar, reklam sektöründe hedef kitlenin beklentisinin sonucu olarak 
multimedya kanalını daha çok tercih etmektedir. Bu nedenle grafik ürünler, basıl-
mak üzere tasarlanmanın yanı sıra multimedya için de tasarlanmaktadır. 
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DERGİ TASARIMI
1.1.1. Derginin Tanımı, Çeşitleri ve Özellikleri
Belirli bir konuda ve belirli aralıklarla yayımlanan grafik ürününe dergi denir. 
Derginin hangi aralıklarla yayımlanacağı içeriğe göre, içerik ise derginin ko-
nusuna ve amacına göre farklılık gösterir. Amaç, hedef kitlenin özelliklerine ve 
beklentilerine göre belirlenir. 

Hedef kitle ve bu kitlenin yaşam koşulları ne olursa olsun herkes bilgiye en hızlı 
ve en kısa sürede ulaşmak ister. Derginin, işlevi gereği belirli bir konu hakkında 
detaylı bilgi veren bir grafik ürün olması ve dergide reklam kanalı olarak da mul-
timedyanın kullanılması ile hedef kitlenin bu beklentisi karşılanmış olur.    

Sinema, bilim, teknoloji, çocuk, magazin, ekonomi, moda, gezi, kültür, tıp, fikir, 
siyaset, kadın, erkek, dinî ilimler, edebiyat, eğitim vb. konularda dergi çeşitleri 
vardır (Görsel 1.2).

Görsel 1.2: Dergi örnekleri

Dergilerin en önemli özelliği görsel bir kişiliğe sahip olmalarıdır. Bunun yanında 
bir dergi tasarımında dikkat edilmesi gereken diğer özellikler şunlardır: 

	● Çoklu sayfa tasarımlarının tamamında olduğu gibi dergi tasarımında da 
bütünlük sağlanmalıdır.

	● Sayfalar; sayfa tasarımının temel ilkeleri olan denge, oran-orantı, gör-
sel hiyerarşi, devamlılık, bütünlük ve vurgulama bakımlarından sorun-
suz olmalıdır.

	● İçerik iyi organize edilmelidir.
	● Yazıların kolay okunabilmesi için uygun font ve ölçü seçilmelidir.
	● Hedef kitleye kolaylık sağlaması açısından içindekiler sayfası olmalıdır.
	● Tipografi dengeli kullanılmalıdır.
	● Derginin yayımlanma alanı için uygun renk modu seçilmelidir.
	● Uygun görseller seçilmelidir.



18Yayın Grafiği

DE
RG

İ T
AS

AR
IM

I

1.1.2. Dergi Ölçüsü ve Önemi
Dergi tasarımında basılacak dergi ve multimedya için standart ölçü 21 x 29,7 cm’dir. 
Standart ölçüden farklı bir ölçü de kullanılabilir. PDF formatında kaydedilen 
dergiler, web sitelerinde otomatik olarak ölçülendirilir.

Basılacak bir dergi tasarımında baskıda kolaylık sağlamak ve maliyeti mini-
mum seviyede tutabilmek için standart kâğıt ölçüleri ve formalama (cilt ve baskı 
çeşidi) göz önünde bulundurulmalı, sayfa sayısı ve ebat planlaması yapılma-
lıdır. Sayfa sayısı, dördün katı olacak şekilde planlanmalıdır. Standart kâğıt 
ölçüleri dışında bir tercih, fire ve maliyet riski göze alınarak yapılabilir.

1.1.3. Dergide Mizanpaj Kuralları
Mizanpaj; grafik ögelerinin belirli bir çerçeve içinde dengeli olarak sayfaya 
yerleştirilmesi, sayfa düzenlemesi ve sayfa planıdır. Dergi mizanpajı ise Gör-
sel 1.3’teki dergi sayfası ögelerinin belirli bir tasarım sonucu dengeli olarak 
yerleştirilmesidir.

Görsel 1.3: Dergi sayfası ögeleri

.ET
K

İN
Lİ

K

1
Sınıf arkadaşlarınızla paylaşım yaparak çeşitli yayın kuruluşlarının dergile-
rini alınız. Dergideki iç sayfa haberlerini sütunlar ve bileşim şekilleri, sayfa-
ların yeri değişmeyen sayfa numaraları, logo, tarih gibi unsurlar, metinler, 
görseller ve görsellerin sayfada yerleşimleri açısından inceleyiniz. Arkadaş-
larınızla görüş alışverişinde bulunarak düzenlemelerle ilgili notlar alınız.

Fotoğraf

Tablo Çerçeve

Çizgi

Başlık

Vektörel 
çizimlerSayfa

numarası

Renk

Yazı
Dergi Sayfası 

Ögeleri
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DERGİ TASARIMI

Dergi mizanpajında dikkat edilmesi gereken hususlar şunlardır:
	● Tasarım, işe başlamadan önce planlamayı gerektirir. Baskı öncesin-

den baskı sonrasına kadar işin geçeceği tüm aşamalar bilinmeli, ona 
göre tasarım yapılmalıdır.  

	● Bilginin etkili bir şekilde verilebilmesi için dikkat edilmesi gereken en 
önemli hususlardan biri imla kurallarıdır. İçerikte uzun soluklu metinler 
ağırlıktaysa bir metin yazarından yardım alınmalıdır.  

	● Tasarımda vurgulanmak istenen mesaja göre tasarım unsurlarının öl-
çülmesi “görsel hiyerarşi” anlamına gelir. Kimi tasarımlarda fotoğraf, 
kimilerinde tipografik unsurlar, kimilerinde renk, kimilerinde ise beyaz 
boşluk ön planda olabilir.  Görsel unsurların orantısal ilişkilerinde de-
ğişken yapılar kurulmalıdır (Görsel 1.4).

	● Basılacak tasarımlarda okunabilirlik açısından en iyi renk kontrastı, 
beyaz zemin üzerine siyah renktir. Multimedya için yapılan tasarım-
larda ise siyah beyaz kontrastına sarı siyah kontrastı da eklenebilir. 

	● Punto, harf büyüklüklerinin tanımlandığı genel ölçü birimidir. 1 punto, 
0,376 mm’dir. Harf büyüklüğü, hedef kitlenin niteliğine göre değişken-
lik gösteren bir husustur; standart değildir. Örneğin dizgilerde 7-12 
yaş çocuklar için genellikle 14-18 punto kullanılırken yetişkinler için 
8-12 punto kullanılır.

	● Tasarımda tekdüzelikten kurtulmak için okunabilirlik ihmal edilmeme-
lidir. Bu nedenle basılacak tasarımlarda metinler uzunsa serifli ka-
rakterler, kısaysa serifsiz karakterler seçilebilir. Multimedya tasarım-
larında ekran çözünürlüğü de göz önünde bulundurulduğunda uzun 
metinler çok olamadığından serifsiz karakterler tercih edilebilir.

Görsel 1.4: Dergi örneği
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	● Yazının gözle algılanabilen kalınlığına et kalınlığı denir. Çok ince yazı-

lar zeminde kaybolur, çok kalın yazılar ise algı güçlüğü yaratır. Basıla-
cak tasarımlarda kuşe kâğıt kullanılırsa et kalınlığı sorun olmaz ancak 
3. hamur kullanılacaksa mürekkep dağılacağından seçilecek fontun et 
kalınlığı daha küçük bir değer olmalıdır. Multimedya tasarımlarda ise 
baskı sorunu olmadığından algılamayı etkilemeyecek şekilde bir değer 
olabilir.

	● Harf arası boşluklar, okunurluğu oldukça etkileyen bir husustur. Met-
nin tamamında kullanılan boşluklarda tutarlılık ve süreklilik olmalıdır. 
Boşlukların belirlenmesinde harf boyutu, satır uzunluğu ve satır arası 
boşluklar gözetilerek düzenli bir yapı oluşturulmalıdır. Özellikle baş-
lık yazımında kullanılan büyük puntolarda düz ve yuvarlak harfler yan 
yana gelmişse düzenleme yapılmalıdır.

	● Dizgi sistemlerinde satır aralığı, genellikle harflere verilen puntonun 
1,5 katına yakın olmalıdır. Örneğin 10 puntoluk bir yazının satır aralığı 
12-15 punto olmalıdır. Çok kısa ve uzun satırlar okuyucuyu yorar. Kısa 
satırlar gözü dikey yönde harekete zorlar, uzun satırlar ise bir alt satırın 
bulunabilmesini güçleştirir. Uzun soluklu metin yazıları için 9-12 punto-
luk bir boyut belirlendiğinde her satıra düşecek sözcük sayısı 10-12'yi 
geçmemelidir. Diğer bir deyişle her satırda 60-70 tipografik karakter 
kullanılmalıdır. Bu sayıların göreceli olmasının yanı sıra hedef kitlenin 
niteliğine göre değişkenlik gösterdiği de unutulmamalıdır.

	● Paragraflar birbirinden rahatlıkla ayırt edilebilmelidir. Bu; paragrafı 
oluşturan cümlenin sol bloğun biraz içinden dizilmesi, paragraflar ara-
sı boşluklar ya da metnin içeriğine göre zeminin renklendirilmesi gibi 
yollarla yapılabilir. 

	● Paragraflar; sola blok, sağa blok, ortalı blok, her iki yana blok ve rast-
gele blok gibi seçeneklerle düzenlenebilir. Sola blok metinler, ortalı 
blok metinlere oranla daha rahat okunur.

1.1.4. Dergi Tasarımında Bölüm ve Şablon Oluşturma
Başarılı ve amacına uygun bir dergi tasarımı için işe başlamadan önce doğru 
bir planlama yapılmalıdır. Bu planlamada dergiyi oluşturan bölümler ve bu bö-
lümlerde kullanılacak şablonlar belirlenmelidir. 
Dergiyi oluşturan bölümler şunlardır:

	● Ön ve arka kapak
	● İçindekiler sayfası
	● Editör sayfası
	● Reklam sayfası 
	● İçerik sayfaları
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DERGİ TASARIMI

Görsel 1.5: Dergiyi oluşturan bölümler

Dergi bölümlerinde içeriğin nasıl organize edileceği ve nasıl detaylandırılacağı 
belirlenmelidir. Şablonda ise genel görünüm, uyum ve bütünlük sağlanmalıdır 
(Görsel 1.5,1.6). Bölümlerin tasarımında kullanılan şablonlarda belirlenmesi ge-
reken özellikler şunlardır:

	● Renk
	● Biçim
	● Font
	● Punto
	● Başlıklar
	● Görseller
	● Metin kullanımı
	● Alt açıklama metinleri

Görsel 1.6: Dergi örneği

1.1.5. Dergi Tasarım Eskizi Oluşturma
Basılacak ve yayımlanacak tasarımlar, günümüzde yazılımlar aracılığıyla ya-
pılıyor olsa da eskiz çalışması oluşturmak zaman ve netlik açısından oldukça 
önemlidir. Hedef kitle niteliği başta olmak üzere derginin konusu ve amacına 
göre bölümler, dolayısıyla şablonlar oluşturulur. Dergi eskizinin hazır olması ya-
zılım aracılığıyla yapılacak dergi tasarımının daha kısa sürede tasarlanmasını 
sağlar.
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ÖĞRENME BİRİMİ: DERGİ TASARIMI 
UYGULAMA ADI  : Dergi Bölümü Oluşturma
AMAÇ		      : Dergi bölümlerinin taslak çalışmasını hazırlamak.

Araç Gereç
1.   A4 kâğıdı
2.   Resim kalemi
3.   Renkli kalemler
4.   Cetvel
5.   Pergel
6.   Silgi

Aşağıdaki işlem basamaklarını dikkate alarak A4 boyutlarında ön 
kapak, arka kapak, içindekiler sayfası, editör sayfası, reklam say-
fası ve 3 içerik sayfasının olduğu 8 sayfalık bir dergi taslağı hazır-
layınız.  

İşlem Basamakları
1.	 Atölye önlüğünüzü giyiniz; araç gerecinizi, çalışma alanınızı iş 

sağlığı ve güvenliği tedbirlerini alarak özenle hazırlayınız.
2.	 Dergi örneklerini inceleyiniz.
3.	 Farklı fikirlere yönelik eskiz araştırmaları yaptıktan sonra es-

kizlerden birini seçiniz.
4.	 Seçtiğiniz eskiz üzerinde renkli kalemlerle görsel, başlık ve  

yazı alanlarını çizerek belirleyiniz.
5.	 Çalışırken oturma pozisyonunuza dikkat ediniz, yanlış oturuş 

şekli sağlığınız için zararlıdır.
6.	 Özgün çalışmalar yaparak taslak maketini oluşturunuz.
7.	 Çalışmanız süresince sabırlı ve dikkatli olmaya özen gösteriniz.
8.	 Zamanınızı verimli kullanmaya dikkat ediniz.

DEĞERLENDİRME
Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. 
Çalışmanız, Ek 1’de verilen “Değerlendirme Formu” ve “Kontrol Liste-
si ”ndeki ölçütlere göre değerlendirilecektir. Çalışmanızı yaparken bu 
ölçütleri dikkate alınız. 
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1.2. MİZANPAJ PROGRAMINDA DERGİ TASARIMI 
Yazılımlar (programlar), bilgisayara nasıl çalışacağını söyleyen komutlar ve 
veriler bütünüdür. Masaüstü yayıncılık yazılımları, temelde üç gruba ayrılır. 
Bunlar; vektörel tabanlı programlar, görüntü işleme programları ve mizan-
paj programlarıdır. Bu programların her birinde birçok grafik ürün yapılabi-
lir. Profesyonel bir çalışma yapabilmek için görüntüler görüntü düzenleme 
programlarında, vektörel işlemler vektörel tabanlı programlarda, çoklu sayfa 
tasarımları ise mizanpaj programlarında oluşturulmalıdır. 

1.2.1. Mizanpaj Programının Genel Anlatımı
Mizanpaj programları, basılı ve dijital ortamlar için sayfa tasarım yazılımla-
rıdır. Kitap, dijital dergi, e-kitap ve etkileşimli PDF hazırlamak için kullanılır. 
Bu program sayesinde baskı alanında tipografi, zengin grafikler, görüntüler 
ve tablolar içeren çoklu sütunlu sayfalar ile kitap, dergi vb. oluşturulabi-
lir. Ayrıca sesler, videolar, slayt gösterileri ve animasyonlar ile dijital dergi, 
e-kitap ve etkileşimli belgeler oluşturulabilir. 

Mizanpaj Programı Arayüzü: Program açıldığında görünen yüzdür 
(Görsel 1.7).

Görsel 1.7: Mizanpaj programı arayüz
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Mizanpaj Programı Menü Çubuğu: Programda yapılacak her türlü işlemin dü-
zenleme komutlarını içerir (Görsel 1.8).

Görsel 1.8: Mizanpaj programı menü çubuğu

File (fayl): Dosya.
Edit (edıt): Çalışma sayfası ve program genel ayarları.
Layout (leyaut): Çalışma sayfası genel ayarları.
Type (tayp): Metinler.
Object (ıbcekt): Çalışma sayfası içinde bulunan objeler.
Table (teybıl): Çalışma sayfası içinde bulunan tablolar.
View (viyu): Çalışma sayfasında yardımcı araçlar ve çalışma görünümü.
Window (vindov): Programın paneller menüsü.
Help: Programda yardım ile ilgili düzenleme komutları.

Mizanpaj Programı Kontrol Paneli: Araçlar panelinde aktif olan araçla ilgili ya-
pılan işlemlerin detaylarının düzenlenebildiği bölümdür. Kontrol panelinde mev-
cut özellikler, her araç için farklılık gösterir (Görsel 1.9).

Görsel 1.9: Mizanpaj programı kontrol paneli

Mizanpaj Programı Araçlar Paneli: Çalışma sayfasında yapılacak her türlü 
çizim, görüntü, metin düzenleme gibi işlemleri gerçekleştirmek için kullanılan 
araçların bulunduğu paneldir (Görsel 1.10). Araç simgesi üzerinde sağ alt köşe-
de bulunan ok işareti, o aracın alt seçeneklerinin de olduğunu gösterir. 

.ET
K

İN
Lİ

K

2
Sınıf arkadaşlarınızla paylaşım yaparak çeşitli yayın kuruluşlarının dergile-
rini alınız. Dergilerdeki iç sayfaların mizanpaj çalışmalarını dikkatlice ince-
leyiniz. Arkadaşlarınızla görüş alışverişinde bulunarak düzenlemelerle ilgili 
notlar alınız. Aldığınız notları sınıfta paylaşınız.

Edit    Layout    Type    Object    Table    View    Window
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Görsel 1.10: Mizanpaj programı araçlar paneli

Direct Selection Tool (Doğrudan 
Seçme Aracı)

Gap Tool (Boşluk Aracı)

Type Tool (Yazı Aracı)

Pen Tool (Kalem Aracı)

Rectangle Frame Tool (Dikdört-
gen Çerçeve Aracı)

Scissors Tool (Makas Aracı)

Gradient Swatch Tool (Degrade 
Renk Örneği Aracı)

Note Tool (Not Aracı)

Hand Tool (El Aracı)

Fill/Stroke Tool (Dolgu/Kontur 
Aracı)

Apply Tool (Uygulama Aracı)

Presentation Tool (Sunum Aracı) View Options Tool (Seçenekler 
Aracını Görüntüleme)

Formating Tool (Biçimlendirme 
Aracı)

Zoom Tool (Yakınlaştırma Aracı)

Colour Theme Tool Renk 
(Teması Aracı)

Gradient Feather Tool (Degrade 
Geçiş Yumuşatma Aracı)

Free Transform Tool (Dönüştürme 
Aracı)

Rectangle Tool (Dikdörtgen 
Aracı)

Pencil Tool (Kalem Aracı)

Line Tool (Çizgi Aracı)

Content Collector Tool (İçerik 
Toplayıcı Aracı)

Page Tool (Sayfa Aracı)

Selection Tool (Seçim Aracı)
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Mizanpaj Programı Window Paneller Menüsü: Çalışma sayfasında yapılacak 
işlemlere detaylı özelliklerin verilebildiği panelleri içerir. Yapılacak işleme göre 
ihtiyaç duyulan paneller düzenlenir (Görsel 1.11).

Görsel 1.11: Mizanpaj prog-
ramı window paneller menüsü

Pages (peycız): Sayfaları düzenlemek için kul-
lanılır. 
Layers (leyırs): Katmanları  düzenlemek için 
kullanılır.
Links: Bağlantıları düzenlemek için kullanılır.
Stroke (sıtrok): Çizgileri düzenlemek için kulla-
nılır. 
Color (kalır): Renkleri düzenlemek için kullanılır.
Properties (pırapırdi): Seçili aracın alt özellikle-
rini düzenlemek için kullanılır.
Paragraph (perıgraf): Paragraf düzenlemek için 
kullanılır.
Character (kerıktır): Yazı karakterini düzenle-
mek için kullanılır.
Glyphs (gılifs): Özel karakterleri düzenlemek 
için kullanılır.
Table (teybıl): Tablo düzenlemek için kullanılır.
Cell Styles (sel sıtayılz) : Hücre stili düzenleme-
si için kullanılır.
Table Styles (teybıl sıtayılz): Tablo stili düzen-
lemesi için kullanılır.

Yeni Belge Oluşturmak
Yeni bir sayfa açmak için File > New > Document komutları kullanılır 
(Görsel 1.12).

Görsel 1.12: Yeni sayfa açma
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Görsel 1.13: New Document panel

Görsel 1.13’teki gibi New Document penceresinden açılan 
belgelerin özellikleri şunlardır:
Width (wıts): Genişlik değeri vermek için kullanılır.
Height (hayt): Yükseklik değeri vermek için kullanılır.
Units (yunıts): Ölçü birimi belirlemek için kullanılır.
Orientation (orienteyşın): Dikey ya da yatay sayfa belirle-
mek için kullanılır.
Pages (peycız): Belgenin sayfa sayısını belirlemek için kul-
lanılır.
Start: Başlangıç sayfasını belirlemek için kullanılır.
Facing Pages (feysing peycız): Karşılıklı sayfa oluşturmak 
için kullanılır.
Columns (kalımz): Sütun sayısı belirlemek için kullanılır.
Columns Gutter (kalımz gatır): Kolonlar arası boşlukları dü-
zenlemek için kullanılır.
Margins (marcınz): Sayfanın iç kısmında boşluk oluşturmak 
için kullanılır.
Bleed and Slug (bılid end sılag): Taşma payı değerlerini 
belirlemek için kullanılır.

BİLGİ NOTU
Margin değeri, sayfa 
tasarımlarında dikkat 
edilmesi gereken ko-
nulardan biridir. Özel bir 
ölçü verilmediği sürece 
sayfanın iç kısmından 2 
cm verilmelidir. Yatayda 
ve dikeyde olmak üzere 
verilen bu bölüme arka 
plan hariç görsel ve tipog-
rafik ögelerin gelmeme-
sine özen gösterilmelidir. 
Bu değerler, çalışmanın 
istenen aşamasında 
Properties panelinden 
de düzenlenebilir. 
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Metin Alanları Oluşturmak ve Özel Karakterler
Metin alanları oluşturmak için Type Tool kullanılır. Araç aktif hâle getirilir, mouse 
sol tuş ile sayfa içinde alan oluşturulur. İmleç, yazı alanının sol üst köşesine 
konumlandırılır. Metin yazılır. 

Metin alanının genel ayarlarını yapmak için araç kutusundan Selection Tool 
ile yazı alanı seçili hâle getirilir (Görsel 1.14). Kontrol panelinden metne geniş-
lik, yükseklik, yatay ve dikey eksende konum, eğim vb. değerler verilir. Metnin 
genel ayarlarını yapmak için araç kutusundan Type Tool ile yazının tamamı ya 
da sadece düzenlenmek istenen bölümü mouse ile seçili hâle getirilir. Kontrol 
panelinden metne font, stil, punto, simge, paragraf, renk vb. değerler verilir. 

Görsel 1.14: Metin alanı oluşturmak

Metin alanına metnin fazla gelmesi durumunda alanın sağ alt köşesinde kırmızı 
artı simgesi görünür. Bu durumda sayfa ölçüsü uygunsa metin alanı artırılabilir, 
sayfa ölçüsü uygun değilse ve farklı bir sayfa gerekliyse ikinci bir yazı alanı oluş-
turularak metnin fazla olan bölümü aktarılmalıdır. Fazla olan metni aktarmak için 
Selection Tool seçiliyken kırmızı artı simgesine bir kez tıklanır, ardından ikinci 
açılan yazı alanına tıklanır. İki metin alanının bağlantılı olduğu artık unutulma-
malıdır (Görsel 1.15, 1.16).

Görsel 1.15: Metin alanı taşması Görsel 1.16: Metin alanları arası bağlantı

.
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Metin alanında sütunlar oluşturma ve paragraf düzenlemesi, kontrol pane-
linden Columns komutu ile yapılabilir. Ayrıca metin alanı seçiliyken Object 
menüsünden ya da sayfa içinde metin alanı üzerine sağ tuş yapılıp açılan 
pencereden Text Frame Options (Ctrl+B) ile de yapılabilir. Text Frame 
Options paneli (Görsel 1.17) ile metne sütun sayısı, genişlik değeri, espas 
değeri, hücre içinden, yukarıdan, aşağıdan, soldan, sağdan olmak üzere 
espas değeri, hizalama gibi özellikler verilebilir. Metin alanları bağlantılı 
olsa dahi farklı sütun ve paragraf düzenlemesi yapılabildiği unutulmamalı-
dır (Görsel 1.18).

Görsel 1.17: Text Frame Options paneli

Görsel 1.18: Metin alanında sütunlar oluşturma

Metne özel karakterler eklemek için Glyphs paneli kullanılır. Kullanılmak iste-
nen karakterin üzerine çift tıklamak yeterlidir (Görsel 1.19). 

Görsel 1.19: Glyphs Paneli ve örneği
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Stil Oluşturmak
Metin stilleri, karakter ve paragraf stillerini içerir. Stil, metnin ya da parag-
rafın tek seferde düzenlenmesi işlemidir. Bu düzenleme işlemi, karakter ya 
da paragraf stil formatlamadır. Formatlama; font, style, renk, espas, size 
vb. değerleri içerir. 

Karakter stil formatı, sadece metin formatlamayı içerirken paragraf stil for-
matı, hem metin hem de paragraf formatlamayı içerir. Oluşturulan her stil 
formatı bir isimle adlandırılır, istenen aşamada bu isim değiştirilebilir, geçer-
siz kılınabilir ve silinebilir.

Stil formatları oluşturmak için Type > Character Styles ve Type > 
Paragraph Styles komutları kullanılır.

Karakter stil formatı için Caracter Styles > Create New Style > Character 
Style Options komutları kullanılır (Görsel 1.20).
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Çeşitli yayın organlarının sayfalarını inceleyerek kendi dergi sayfanızı oluş-
turunuz. Çalışmanız üzerinde metin alanı oluşturma, sütunlara ayırma, me-
tin yazma, metin alanına sığmayan metni yandaki sütuna taşıma gibi özel-
likleri mizanpaj programında çalışınız.

BİLGİ NOTU
Bir çalışma dosyasının içinde birden çok 
karakter ve paragraf stil formatı olabilece-
ği unutulmamalıdır. Oluşturulan stillerden 
hangisi kullanılmak isteniyorsa o isim seçil-
melidir.

Görsel 1.20: Type menü
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Görsel 1.21: Character Style Options panel

Oluşturulan stili uygulamak için karakter ya da karakterler seçilir. Bunun için 
Character Styles > Character Style 1 ismi üzerine tıklanır. 

Paragraf stil formatı için Paragraph Styles > Create New Style > Paragraph 
Style Options komutları kullanılır (Görsel 1.21).

Oluşturulan stili uygulamak için paragraf ya da paragraflar seçilir.  Bunun için 
Paragraph Styles > Paragraph Style 1 ismi üzerine tıklanır. Herhangi bir 
sürümde hazırlanmış başka belgeden stilleri içe aktarmak için kullanılmak 
istenen belge aktifken Paragraph Styles > Load Paragraph Styles ya da 
Character Styles > Load Character Stles komutları kullanılır (Görsel 1.22).

Görsel 1.22: Paragraph Style Options panel

BİLGİ NOTU
Oluşturulan stil for-
matında herhangi bir 
değişiklik yapıldığında 
uygulanan her metin 
ya da paragraf gün-
cellenmelidir.
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Stillerin tamamını aktarmak için Paragraph ya da Character Styles > Stil, 
silmek için Character Styles ya da Paragraph Styles > Delete Style ko-
mutları kullanılır. Oluşturulan stil silindiğinde yerini alması için başka 
bir stil belirlenebilir ya da biçimlendirmenin korunup korunmayacağı 
seçilebilir (Görsel 1.23).

Görsel 1.23: Paragraph Style ve Character Styles menü

Stil silmek için Character Styles ya da Paragraph Styles > Delete Style 
komutları kullanılır. Oluşturulan stil silindiğinde yerini alması için başka bir 
stil belirlenebilir ya da biçimlendirmenin korunup korunmayacağı seçilebilir 
(Görsel 1.24).

Görsel 1.24: Paragraph Style ve Character Styles menü

BİLGİ NOTU
Stil aktarımında var olan stil isimleri kontrol 
edilmelidir. Stil isimlerinin çakışma ihtimali göz 
önünde bulundurularak gerekli düzenleme yapıl-
malıdır. Aksi takdirde yeni aktarılan stil eski olanı 
geçersiz kılar. 
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Ana Sayfa (Kalıp Sayfa) Oluşturmak
Çalışma belgesinin içinde bulunan birden çok sayfadaki ortak kullanılacak 
ögelerin bir defa yerleştirilmesi koşulu ile hazırlanan sayfalardır. Belge için-
de bir ya da birden çok ana sayfa olabilir. Belge sayfaları, ana sayfalardan 
çoğaltma yolu ile oluşturulur. Ana sayfa içinde bulunan nesneler (logo, sayfa 
numarası vb.) ve herhangi bir aşamada yapılan değişiklikler tüm belge say-
falarında görünür. 

Çoklu sayfa tasarımları mizanpaj programında sol sayfa ve sağ sayfa olarak 
farklı biçimlendirmeye tabidir. Aksi belirtilmediği sürece belgeler sağ sayfa-
dan başlar. Hangi sayfada çalışma yapılacaksa Pages panelinden o sayfa 
üzerine çift tıklanarak sayfa aktif hâle getirilmelidir (Görsel 1.25).  

Görsel 1.25: Pages paneli

Numaralandırmak
Numara genel olarak sol ve sağ ana sayfa olmak üzere ikisine ayrı ayrı ek-
lenir. Sayfa numarası eklemek için ana sayfalardan sol ana sayfaya ve sağ 
ana sayfaya çift tıklanarak sayfalar Page panelinden aktif hâle getirilir. Belge 
sayfalarına sayfa numarası eklemek için görülmesi istenen konuma en uzun 
sayfa numarasının sığabileceği kadar metin çerçevesi eklenir. Metne çift tıkla-
narak metin seçili hâle getirilir. Type > Insert Special Caracter > Markers > 
Current Page Number komutları uygulanır (Görsel 1.26).

Görsel 1.26: Type menüsü

BİLGİ NOTU
Aksi belirtilmediği sürece 
ana sayfadaki nesneler, 
belge sayfasındaki bütün 
nesnelerin arkasında gö-
rünür. 
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Nesneler
Mizanpaj programında içe nesne aktarımı yapılabildiği gibi yeni nesneler de 
oluşturulabilir. Nesne, uyumlu programlarda oluşturulmuşsa içe nesne ak-
tarmak için Ctrl+C (kopyala) ve Ctrl+V (yapıştır) kullanılır. Nesne herhangi 
bir programda oluşturulmuşsa EPS formatında kaydedildikten sonra File > 
Place komutları kullanılır. 

Yeni nesne oluşturmak için araç kutusundan Line Tool, Pencil Tool, Pen 
Tool, Rectangle Tool çizim araçları; Selection Tool, Direct Selection 
Tool, Scissors Tool, Free Transform Tool seçim ve düzenleme araçları; 
Colour Picker, Gradient Swatch Tool, Gradient Feather Tool renklendir-
me araçları kullanılır.

Görseller 
Mizanpaj programında farklı formatlarda görseller ile çalışılabilir. Görseller, 
sayfa içine bağlantı kurularak getirilir ve gerekli bilgi Links panelinden gö-
rüntülenir (Görsel 1.27). 

Görsel 1.27: Links paneli

Sayfa içine görsel eklemek için File > Place komutu kullanılır. Görseller, 
sayfa içinde direkt kullanılabileceği gibi bir çerçeve içinde de verilebilir. Çer-
çeve içine görsel eklemek için araç kutusundan Frame Tool (freym tul) kul-
lanılır (Görsel 1.28).

Görsel 1.28: Frame Tool

BİLGİ NOTU
Link paneli, çoklu sayfa 
tasarımlarında kayıt ön-
cesinde kontrol edilme-
si gereken bir paneldir. 
Bağlantı yolu ile getirilen 
her şey burada görülme-
lidir. Aksi takdirde dosya-
da görünmeyecektir.
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Çerçeve içinde kullanılan görseller, üzerine çift tıklanarak seçili hâle getirilir 
ve gerekliyse görsellerde düzenleme yapılabilir. Görsel ve metinler arasında 
bağlantı kurmak için Text Wrap (tekst rap) paneli kullanılır (Görsel 1.29). Bu 
panelden metin ve görsel bağlantısının ne şekilde görüneceği, metnin dört 
kenarındaki boşluklar ve bağlantı seçenekleri düzenlenebilir.

Görsel 1.29: Text Wrap panel

İçindekiler Bölümü Oluşturmak
Çoklu sayfa tasarımlarında grafik ürünün içindekilerini (metinler, görseller, 
grafikler vb.) listelemektir. İçindekiler bölümü, okuyucuların ürün içindeki bil-
gilere hızlı bir şekilde ulaşabilmesi için bir başlıktan ve sayfa numarasına 
göre sıralanan giriş bölümünden oluşur. Mizanpaj programında içindekiler 
bölümü oluşturmak için bu bölümde görünmesi istenen başlıklara atanmak 
üzere Görsel 1.30’daki “başlık” yazan bölümde Paragraph Style oluşturulur. 
Başlık ve sayfa numarası arasında “…..” olması istenirse Görsel 1.30’daki 
gibi  “…..” yazan bölümde Paragraph Style oluşturulur. 

Görsel 1.30: Paragraph Styles panel
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Stil atamaları yapıldıktan sonra Layout  > Table of Contents komutu ile belirle-
nen özellikler şunlardır:

	● Title (taytıl)  ile içindekiler bölümünde görünmesi istenen başlığa isim 
verilir.

	● Other Styles bölümünden “başlık” stili seçilir ve Add komutu ile 
Include Paragraph Styles bölümüne aktarılır (Görsel 1.32). 

	● Entry Style başlık ile sayfa numarası arası için oluşturulan stil seçilir.
	● Page Number ile sayfa numarasının konumu seçilir.
	● Tab ayarı ile sayfa düzenlemesi yapılır (Görsel 1.31).

Görsel 1.31: Table of Contents panel

Görsel 1.32: Paragraph Style Options panel

BİLGİ NOTU
Tablolar, web sayfası ta-
sarımında genel sayfa 
düzenlemesi için kullanı-
lan seçeneklerden biridir.



37 Yayın Grafiği

DERGİ TASARIMI
Tablolar
Mizanpaj programında tablolar; sayfa içinde metin, grafik vb.ni düzenlemek 
için kullanılabileceği gibi sayfanın genel düzenlemesi için de kullanılabilir. 
Tablolar, satır ve sütun olmak üzere hücrelerden oluşur. İstenen aşamada 
renklendirme, ölçülendirme, satır ya da sütun ekleme ve çıkarma, hücre bir-
leştirme ve bölme düzenlemesi yapılabilir. Yeni tablo oluşturmak için Table > 
Create Table komutu kullanılır (Görsel 1.33).

Görsel 1.33: Table menü

Create Table (kırieyt teybıl)  panelindeki Body Rows’dan satır, Columns’dan 
sütun, Header Rows’dan başlık satırı, Footer Rows’dan alt bilgi satırı, Table 
Style’dan tablo stili için değerler verilerek tablolar oluşturulur (Görsel 1.34). 

Görsel 1.34: Create Table panel

Oluşturulan tablo ile ilgili değerlerin düzenlenebileceği panel, Window > 
Type&Tables > Table komutları ile açılır. Table panelinden satır, sütun, 
hücre ve iç bölümünde yer alan içerik dâhil olmak üzere hizalama ve 
ölçülendirme yapılabilir. Ayrıca tabloda bir hücre ya da birden çok hücre 
seçiliyken Properties (pırapırtiz) panelinden renklendirme, çerçeve bi-
çimlendirmesi, hizalama düzenlemeleri yapılabilir. Window > Properties  
komutları ile açılır. 
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Görsel 1.35: Table panel

Çoklu sayfa tasarım çalışmalarında bölüm ve şablonlar, ana sayfa 
(kalıp sayfa) olarak metin alanları yoluyla oluşturulabildiği gibi tab-
lolar yardımıyla da oluşturulabilir (Görsel 1.35). Etkileşimli belgeler 
oluşturabilmek için tabloların daha çok kullanıldığı göz önünde bu-
lundurulmalıdır.

1.2.2. Mizanpaj Programında Uygun Formatta 
         Kaydetmek 
Yapılan her çalışmanın, kullanılan programın düzenlenebilir kayıt 
türü seçilerek mutlaka kaydedilmesi gereklidir. Baskı için hazırlanan 
çalışmalarda mizanpaj programında File > Package (pakıc)  komu-
tu ile dosyalar paket hâlinde kaydedilebilir. Package ile kaydedilen 
dosyaların içinde düzenlenebilir kayıt türü formatı olmakla birlikte 
PDF formatı, tüm gerekli fontlar, bağlantı kurulmuş grafikler, metin 
dosyaları ve özelleştirilmiş bir rapor da mevcuttur. 

Yayın için hazırlanan çalışmalarda File > Publish Online (pabliş  
onlayn) komutu ile çevrim içi belge yayımlanabilir. File > Export 
komutu ile farklı formatlar için dışa aktarım yapılır. HTML, PDF 
(interactive) vb. yayımlanacak yere göre kayıt türü seçilir.

Hazırlanan çalışmalar baskı için matbaaya gönderilir. Matbaaya gi-
den çalışmalar, kontrol edilmek ve baskıya hazırlanmak için bilgisa-
yarda açılır ve gerekli işlemler yapıldıktan sonra baskı yapılır. Ancak 
giden çalışmalarda fotoğraf vb. eksik ögeler varsa baskı sürecinde 
sorunlar yaşanır. Bu tarz sorunların önüne geçmek için mizanpaj 
programında yapılan sayfa tasarımlarında kullanılan tüm fotoğraf, 
illüstrasyon, font vb.nin aynı dosyaya toplandığı bir özellik vardır. 
Buna Package denir. Package genellikle çalışma bitirildikten son-
ra yapılır. Çalışma bitirildikten sonra mizanpaj programının altında 
bulunan hata kontrol paneline (Preflight) bakılır. Burası No Errors 
ve yeşil renk ise bu çalışma sayfalarında tekst kaybı ya da kaynağı 
bilinmeyen bir görsel olmadığı anlama gelir.



39 Yayın Grafiği

DERGİ TASARIMI

Görsel 1.36: Hata kontrol paneli

Hata kontrol paneli kontrol edildikten sonra sayfada kullanılan renk formatına 
da bakılır (Görsel 1.36). CMYK dışındaki renkler CMYK’ye çevrilir. Çalışma say-
fasının mizanpaj programı formatında bir kopyası alındıktan sonra tüm yazılar 
convertlenir ve File > Package komutu verilir (Görsel 1.37, 1.38). 

Görsel 1.37: Package komutu

  Görsel 1.38: Package komut seçenekleri

Package

Package
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Görsel 1.39: Dosaya kaydetme

Görsel 1.40: Package oluşturma       

Package işlemi yapıldıktan sonra o dosya içinde bulunan çalışma sayfası açılır 
ve prova baskısı için ayarlamalar yapılır. Fontlar convertlenir, gruplanması gere-
ken ögeler gruplanır, ölçüler son kez kontrol edilir ve prova baskısı alınır. Alınan 
baskıda yazılar, görseller vb. kontrol edildikten sonra çalışma baskı için matbaaya 
gönderilir.

Açılan panelde çalışma içinde bulunan görseller, fontlar, renkler vb. ile ilgili bil-
giler ve varsa hataları gösteren sekmeler bulunur. Bu kısımlardan da çalışma 
kontrolleri yapılabilir. Kontrollerden sonra Package komutuyla işleme devam 
edilir. Yeni açılan pencereden, oluşturulacak dosyanın adı ve kaydedileceği yer 
belirlenir (Görsel 1.39). Package komutuyla işlem sonlandırılır (Görsel 1.40).
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ÖĞRENME BİRİMİ: DERGİ TASARIMI 
UYGULAMA ADI  : Dergi Sayfası Hazırlama 
AMAÇ		       : Dergi sayfasını mizanpaj programında hazırlamak.

Araç Gereç
1.	 Bilgisayar
2.	 Tarayıcı
3.	 Grafik tasarım programları
4.	 İnternet

Aşağıdaki işlem basamaklarını dikkate alarak ön kapak, arka kapak, 
içindekiler sayfası, editör sayfası, reklam sayfası ve 3 içerik say-
fasının olduğu 8 sayfalık bir dergi tasarım yapınız. 

İşlem Basamakları
1.	 Atölye önlüğünüzü giyiniz; araç gerecinizi, çalışma alanınızı iş 

sağlığı ve güvenliği tedbirlerini alarak özenle hazırlayınız.
2.	 Bilgisayarı çalışmaya hazır hâle getiriniz. 
3.	 A4 boyutlarında bir çalışma sayfası açınız.
4.	 Konunuza uygun metinleri ve görselleri toplayınız.
5.	 Dosyayı bilgisayarda uygun yere, mizanpaj programının kendi 

formatında kaydediniz.
6.	 Çalışırken oturma pozisyonunuza dikkat ediniz, yanlış oturuş 

şekli sağlığınız için zararlıdır.
7.	 Başlık ve metinlerin karakter ve büyüklüklerini özenle belirleyiniz.
8.	 Kullanılacak görselleri teknik açıdan uygun hâle getiriniz.
9.	 Çalışmanız süresince sabırlı ve dikkatli olmaya özen gösteriniz.
10.	Çalışmanızı hem paket olarak hem de PDF formatında kaydediniz. 
11.	 Çalışmanızın A4 boyutlarında çıktısını alarak sayfalarını kontrol 

ediniz. 

DEĞERLENDİRME
Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. 
Çalışmanız, Ek 1’de verilen “Değerlendirme Formu” ve “Kontrol Liste-
si ”ndeki ölçütlere göre değerlendirilecektir. Çalışmanızı yaparken bu 
ölçütleri dikkate alınız. 

2.
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1.3. DERGİ KAPAĞI TASARIMI
Görsel bir kimlik oluşturulmuş dergi tasarımında göze ilk hitap eden ve hafıza-
larda yer eden bölüm kapaktır (Görsel 1.41, 1.42). 

Görsel 1.41: Dergi kapağı

1.3.1. Dergi Kapağının Önemi ve Özellikleri
En önemli özelliği dergi isminin görünmeden de görsel tasarım yolu ile anla-
şılmasıdır. Dergi tasarımında içerik hedef kitle özelliklerine göre belirlenirken 
kapak içeriğe göre belirlenir. İçerikteki bilgiler, kapakta gerek bir fotoğraf gerek 
bir metin ile merak uyandırılmalı ve ön bilgi niteliğinde belirtilmelidir.

Dergi kapağı çalışması, içerik bilgileri dikkate alınarak bazı bilgiler doğrultu-
sunda hazırlanmalıdır. 

	● Dergi kapağını benzerlerinden ayıran belirgin ipuçları oluş-		
	 turulmalıdır. 

	● Görsel hiyerarşi oluşturulmalıdır.
	● Görüntüler ve tipografi arasında denge sağlanmalıdır. 
	● Arka plan, içerik ve genel ile uyumlu olmalıdır.
	● Odak noktası oluşturulmalıdır.
	● Renk, ışık ve kontrastlık değeri canlı ve uyumlu olmalıdır.
	● Sanatsal açıdan sade, yalın ve estetik olmalıdır.
	● Sayfa tasarımı ilkeleri dikkate alınmalıdır.
	● Ön ve arka kapak tutarlı ve çok uyumlu olmalıdır. 
	● Beyaz boşluklar tasarı ilkelerine göre etkili kullanılmalıdır.

Görsel 1.42: Dergi kapağı
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1.3.2. Dergi Kapağında Kullanılacak Tasarım Elemanlarının 	
          Düzenlenmesi
Dergi kapağını oluşturacak tasarım elemanlarının, sayfa tasarım ilkeleri ve 
tasarı ilkeleri dikkate alınarak düzenlenmesi gerekir. Tasarımcı, öncelikle ça-
lışacağı konu ile ilgili detaylı araştırma yaparak bilgi sahibi olmalıdır. Yapılmış 
başarılı çalışmaları incelemek de ayrıca farkındalığı artırır (Görsel 1.43). 

Görsel kimlik oluşturabilmek için kapakta kullanılan renk, çizgi, grafik vb. ele-
manlar kendi içinde ve genel ile tutarlı, uyumlu, dengeli olmalıdır. İçerikte bu-
lunan ve dikkat çekilmek istenen konulara kapakta yer verilmelidir. İçerikteki 
başlıklardan bazılarına kapakta yer verilebilir.

Görsel 1.43: Dergi kapağı

Ölçülendirme: Dergi tasarımı kapak çalışması, yayımlanmak üzere yapılıyor-
sa mizanpaj programında ya da vektörel tabanlı programda içerik ile aynı öl-
çüde tasarlanabilir. Basılmak üzere yapılıyorsa kırım ve kesme işlemlerinden 
dolayı taşma payları ilave edilmeli, özel bir ölçü verilmediyse içerik sayfaları 
ölçüsüne yatayda ve dikeyde 4 cm ilave edilip hazırlanmalıdır. 

Tasarım elemanlarının ölçülendirilmesinde elemanların tasarım sıralamasına 
dikkat edilmelidir.

	● Kapak tasarımında dikkat çekmesi istenen ilk eleman logotypetır. Fark 
edilir ve görünür ölçüde olmalıdır. 

	● Kapakta kullanılan görsel ölçüsü, sayfa geneline uygun ölçüde ve ti-
pografiyi kapatmayacak kadar olmalıdır.

	● Arka planda kullanılan renk ya da görsel, dikkati çekmeyecek ve diğer 
elemanları tamamlar ölçüde olmalıdır.

	● Tipografi ölçüsü, kapak geneli ve kullanılan kapak görseli ile orantılı 
olmalıdır.

	● Kullanılan beyaz boşluk oranı, kapak geneli ile orantılı olmalıdır. Unu-
tulmamalıdır ki beyaz boşluk, istenen her şeyi görünür kılar.  

BİLGİ NOTU
Görseller, piksel taban-
lı görüntü düzenleme 
programında detaylı 
şekilde düzenlenerek 
vektörel tabanlı prog-
rama ya da mizanpaj 
programına aktarılma-
lıdır.
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Görsellerin Seçimi ve Düzenlenmesi: Görüntülerin net olması ilk 
kuraldır. Kullanılan görsellerin renk, ışık, çözünürlük değerleri netlik 
için önemlidir. Kapak ya da içerikte kullanılan her görsel; renk, ışık 
ve çözünürlük bakımından düzenlenmelidir. Bu düzenleme ile hem 
görseller arası hem de genel uyum sağlanmalıdır. Kullanılan her gör-
selin içerik ve sayfa yapısıyla uyumlu olmasına özen gösterilmelidir.

Görsellerin renk modu, basılacak dergi tasarımlarında CMYK; ya-
yınlanacak dergi tasarımlarında RGB olmalıdır. Arka planı olmadan 
kullanılmak istenen görseller, özellikle dekupe edilmelidir. Piksel ta-
banlı görüntü düzenleme programında düzenlemesi yapılan görsel-
ler, File > Save As komutu ile istenen formatta (JPEG, TİFF ya da 
PNG) kaydedilmelidir.

Font Seçimi ve Kullanımı: Derginin basılacak ya da yayımlanacak 
olması dikkate alınarak içeriğe göre font seçimi yapılmalıdır. Yazıla-
rın okunaklı olması ve zorunlu olmadığı sürece dikkat dağıtmaması 
açısından çok farklı fontlar aynı sayfada kullanılmamalıdır. Gerekirse 
bir fontun farklı stilleri kullanılabilir. Uzun soluklu metinler varsa özel-
likle okunurluk ön planda olmalıdır. Örneğin yaş ve seviye dikkate 
alınarak çocuk dergilerinde eğlenceli fontlar seçilebilir. 

Logo ve Barkod Kullanımı: Dergi tasarımında logotype kullanı-
mı oldukça önemlidir. Her ne kadar görsel kimlik oluşturulmuş olsa 
da satış yerlerinde raflardaki sıralama ve diğer dergi ölçüleri de 
düşünülmelidir. Dergi belli bir mesafeden de okunabilir olmalıdır. 
Yayımlanacak dergi tasarımlarında dijital ortam ve benzer dergiler 
düşünüldüğünde derginin rakiplerinden ayrı ve fark edilebilir olması 
sağlanmalıdır.

Dergi kapağı tasarımında özellikle ön kapakta olması gerekenler; 
barkod, tarih, sayı ve fiyattır. Bunlar çok büyük ölçülerde olmamalı 
ve genel itibariyle kapağın görünür bir bölümünde kullanılmalıdır. Bu 
bilgilerin de isim niteliğinde ve açıklayıcı bilgi olarak düşünülmesinde 
fayda vardır. Örneğin derginin sayısı satış açısından önemlidir.
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1.3.3. Dergi Kapağı Kayıt Seçenekleri, Baskı ve Yayın
Yapılan çalışma öncelikle, programın düzenlenebilir kayıt formatında kayde-
dilmelidir. Kapak vektörel tabanlı programda yapılmışsa yayımlanmak üzere 
hazırlanmış bir dergi kapağı tasarımı, File > Save As komutu ile PDF forma-
tında kaydedilerek ayrıca içeriğe eklenebilir. Basılmak üzere hazırlanmış bir 
dergi kapağı tasarımına öncelikle Object > Create Trim Marks komutu ile 
kros verilmelidir (Görsel 1.44). Ardından File > Save As komutu ile PDF ya 
da EPS formatlarında kaydedilebilir. File > Export komutu ile JPEG, TİFF ve 
PNG formatlarında kaydedilebilir. 

Görsel 1.44: Kros işlemi

Kapak, mizanpaj programında yapılmış ve yayımlanmak üzere hazırlanmış-
sa bütün hâlinde kaydedilerek yayımlanabilir. Basılmak üzere hazırlanmışsa 
yine öncelikle kapağa kros verilmelidir. Ardından kapak içerik sayfalarına ek-
lenerek bütün dosya File > Package komutu ile paket hâlinde kaydedilebilir. 
Kapak ayrıca File > Export komutu ile PDF, JPEG, PNG formatlarında kay-
dedilerek Package dosyasına eklenebilir. 
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ÖĞRENME BİRİMİ: DERGİ TASARIMI 
UYGULAMA ADI  : Mizanpaj Programında Dergi Kapağı Oluşturma 
AMAÇ		       : Mizanpaj programında dergi kapağı çalışması 	
	                    yapmak.

Araç Gereç
1.	 Bilgisayar
2.	 Tarayıcı
3.	 Mizanpaj programları
4.	 İnternet

Aşağıdaki işlem basamaklarını dikkate alarak 2. Uygulama’da ha-
zırladığınız dergi tasarımına uygun kapağı oluşturunuz.

İşlem Basamakları
1.	 Atölye önlüğünüzü giyiniz; araç gerecinizi, çalışma alanınızı iş sağlı-

ğı ve güvenliği tedbirlerini alarak özenle hazırlayınız.
2.	 Bilgisayarı çalışmaya hazır hâle getiriniz. 
3.	 A4 boyutlarında bir çalışma sayfası açınız.
4.	 Dosyayı bilgisayarda uygun yere, mizanpaj programının kendi for-

matında kaydediniz.
5.	 Çalışırken oturma pozisyonunuza dikkat ediniz, yanlış oturuş şekli 

sağlığınız için zararlıdır.
6.	 Sayfanıza logo, reklam, tablo ve yaptığınız düzenlemenin gerektirdi-

ği sabit unsurları yerleştiriniz.
7.	 Konunuza uygun metinleri ve görselleri toplayınız.
8.	 Başlık ve metinlerin karakter ve büyüklüklerini özenle belirleyiniz.
9.	 Kullanılacak görselleri teknik açıdan uygun hâle getiriniz.
10.	Uygun görsellerle birlikte logo ve metinleri sayfaya yerleştiriniz.
11.	 Çalışmanız süresince sabırlı ve dikkatli olmaya özen gösteriniz.
12.	Çalışmanızı mizanpaj programının kendi formatında ve de PDF for-

matında kaydediniz. 
13.	Çalışmanızın A4 boyutlarında çıktısını alarak sayfalarını kontrol ediniz. 

DEĞERLENDİRME
Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. 
Çalışmanız, Ek 1’de verilen “Değerlendirme Formu” ve “Kontrol Liste-
si ”ndeki ölçütlere göre değerlendirilecektir. Çalışmanızı yaparken bu 
ölçütleri dikkate alınız. 
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A)  Aşağıda verilen cümlelerin başındaki parantezlere cümleler doğru ise “D”, yanlış ise 	
      “Y” yazınız. 

1.	 (   ) Masaüstü yayıncılıkta grafik ürünleri içinde, ilk sıralarda dergi, gazete ve kitap 	
	      gelmektedir.

2.	 (   ) Yazının uzunluğuna et kalınlığı denir.
3.	 (   ) Belirli aralıklarla yayımlanan grafik ürününe dergi denir.
4.	 (   ) Dergi tasarımında göze ilk hitap eden ve hafızalarda yer eden bölüm içindekiler say-	

	      fasıdır.
5.	 (   ) Dergi tasarımında görsel seçilirken ilk kural görüntülerin net olmasıdır.

B)  Aşağıda verilen cümlelerde yer alan boşlukları doğru ifadelerle doldurunuz.
6.	 Dergi tasarımında ölçü, aksi belirtilmediği sürece …………………....... cm’dir.
7.	 Mizanpaj programına özel karakterler eklemek için ……………….......... paneli kullanılır.
8.	 Harf büyüklüklerinin tanımlandığı genel ölçü birimine ………...............….denir.
9.	 Basılı ve dijital ortamlar için sayfa tasarımında ……………..........…programları kullanılır.

C)  Aşağıda verilen soruların doğru cevaplarını işaretleyiniz. 
10.	 Aşağıdakilerden hangisi dergiyi oluşturan bölümlerden değildir? 
	 A)   Editör sayfası
	 B)   İçindekiler sayfası
	 C)   Reklam sayfası
	 D)   Spor sayfası
	 E)   Ön ve arka kapak
11.	 Aşağıdaki panellerden hangisi seçilen aracın özelliklerini düzenlemek için kullanılır?

A)   Link           B)   Pages         C)   Properties       D)   Table          E)   Table styles
12.	 Aşağıdakilerden hangisi çalışma sayfasında metin alanları oluşturmak için kullanılır? 
	 A)   Gap Tool   B)   Hand Tool    C)   Scissors Tool   D)   Type Tool    E)   View Options Tool
13.	 Aşağıdakilerden hangisi ile çalışma sayfası genel ayarları düzenlenebilir?
	 A)  Layout        B)  Object          C)  Table                D)  View            E)  Window

D)  Aşağıda verilen soruların cevaplarını noktalı yerlere yazınız.
14.	Dergi tasarımında kullanılacak görsellerin seçiminde dikkat edilmesi gereken özellikler 

nelerdir?
	 ……………………………………………………………………………………………………

…………………………………….……………………………………………………………
………………………………………………………………………………………………..…

 15.	Dergi kapağı çalışmasında dikkat edilmesi gereken özelliklerden beş tanesini yazınız?
	 ……………………………………………………………………………………………………

…………………………………….……………………………………………………………
……………………………………………………………………………………………….…

ÖLÇME VE DEĞERLENDİRME



Öğrenme 
Birimi

GAZETE
SAYFASI
HAZIRLAMA

GAZETE
SAYFASI
HAZIRLAMA

2.2.



KONULAR
2.1. GAZETENİN İÇ VE ARKA SAYFA 			 
	    TASARIMI
2.2. GAZETE BİRİNCİ (ÖN) SAYFA 
	    TASARIMI 

TEMEL KAVRAMLAR
•	 gazete
•	 mizanpaj 
•	 manşet      
•	 şablon  
•	 logo    

NELER ÖĞRENECEKSİNİZ?
•	 Gazete mizanpaj kuralları
•	 İç sayfa ve arka sayfa tasarım özellikleri
•	 Haber, ekonomi, kültür sanat, spor, magazin, arka sayfa, ilan, rek-

lam sayfalarının özellikleri ve  bu sayfalarda yer alabilecek konular 
•	 Gazete sayfası taslak planı hazırlama ve bunu mizanpaj progra-

mında hazırlama
•	 Birinci sayfanın özellikleri ve tasarımda olması gerekenler
•	 Birinci sayfa hazırlanırken manşetin önemi
•	 Birinci sayfa hazırlanırken manşetin yerini ve büyüklüğünü, logo-

nun yerini planlama 
•	 Birinci sayfa şablonu hazırlama
•	 Mizanpaj programında sayfayı paket olarak kaydetme ve prova 

baskısı alma 

Hazırlık Çalışmaları
1.	 Gazete okurken en çok hangi sayfalar dikkatinizi çeker?
2.	 Gazete sayfalarının tasarım özelliklerinden dikkatinizi çeken-

leri arkadaşlarınızla paylaşınız.
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Tarihsel kayıtlara göre 
ilk haber gazetesi MÖ 
59 yılında 2000 kopya 
olarak Julius Caesar’ın  
(Culyıs Sizır) emriyle 
Roma Senatosunca çı-
karılan, imparatorluğun 
değişik köşelerine dağı-
tılan, bilinen gazetelerin 
atası olarak kabul edilen 
“Acta Diurna” (Günlük 
Olaylar) isimli bültenler-
dir (Ana Britannica, Cilt 
1, Sayfa 60 ‘Acta’).

2.1. GAZETENİN İÇ VE ARKA SAYFA 	
       TASARIMI 
Gazetenin tarihî gelişimine bakıldığında haberler; ilk 
olarak taş, kil gibi malzemelerin üzerine kazılırken son-
raları papirüs ve parşömen üzerine yazılmıştır. Mat-
baanın icadı ile harfler, elle yan yana bir düzen içinde 
dizilmiş; böylece daha fazla sayıda sayfa okuyucuya 
ulaştırılmıştır. Teknolojinin sürekli olarak gelişimi sonu-
cu baskı makineleriyle beraber tasarım da bu sürece 
dâhil edilmiştir. 

Grafik tasarımcıların çalışma alanlarından birisi de 
gazetedir. Günümüzde internetin yaygınlaşması, her 
yerde olduğu gibi gazeteler üzerinde de etkisini gös-
termiştir. Gazeteler basılı olarak devam ettiği gibi aynı 
zamanda dijital ortamlarda hizmet vermektedir. Bunun 
yanı sıra haberi oluşturan yazıların ve görsellerin in-
ternet ortamına taşınması basılı yayıncılıktaki tirajları 
da düşürmüştür. Basılı yayının dijital alana yönelmesi 
baskı kısmında değişikliğe sebep olduğu için tasarımı-
nı dijital ortamda oluşturan  tasarımcının işinde azalma 
olmaz. 

Bir gazetenin diğer gazeteler arasından sıyrılıp dikkat 
çekmesi ve tercih edilmesi için sayfa tasarımı önemli-
dir. Tasarımda asıl amaç, haber ve yazıların okuyucu 
tarafından kolayca algılanmasını sağlamaktır. Sadece 
iyi bir içerik, okuyucuyu etkilemek için yeterli değildir. 
Görsel estetik de gazetenin tercih edilmesi için önemli-
dir. Sayfa tasarımın diğer bir amacı da haberleri önem 
sırasına göre düzenlemektir. Okuyucu, ilgilendiği habe-
ri veya yazıyı kolaylıkla bulabilmelidir. Ayrıca gazetenin 
genelinde font, fotoğraf ve renklerin kullanımı, başlık 
düzenlemeleri, metin yerleşimleri ile oluşturulacak öz-
gün tasarım da onun diğer gazetelerden ayrılmasını 
sağlar. 

2.1.1. Gazete Mizanpajı
Gazete sayfası tasarlanırken sayfayı planlamak ve 
düzenlemek için en iyi yol sayfayı sütunlara bölmektir. 
Sayfa tasarımı yapılırken, oluşturulan sütunlar Görsel 
2.1’deki gibi metin veya görsel kutularına kılavuz olarak 
alınır; çeşitli şekillerde birleştirilerek metinler ve görsel-
ler yerleştirilir. Sayfanın sütunlara bölünmesi bütünlü-
ğün ve devamlılığın sağlanması açısından da önemlidir. 
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Görsel 2.1: Gazete mizanpaj örneği

GAZETE İSMİ

        Gazetenin tarihi gelişiminde ilk olarak haber sayfaları taş, kil 
gibi malzemelerin üzerine kazınarak kullanılırken songhhhhraları 
papirüs ve parşömen üzerine yazılmıştır. Matbaanıghn geliş icadı 
ile har�er elle yan yana dizilerek bir düzen içinde daha fazlhhhha 
sayıda sayfa okuyucuya ulaştırılmıştır. Teknolojinin sürekli olarak 
gelişimi sonucu baskı makineleriyle beraber tasarım da bu sürece 
dâhil edilmiştir. 
        Günümüzde internetin yaygınlaşması her yerde olduğu gibi 
gazeteler üzerinde de etkisini göstermiştir. Gazeteler basılı olarak 
devam ettiği gibi aynı zamanda dijital ortamlarda hihghjgzmet 
vermektedir. Bunun yanı sıra haberi oluşturan yazılaghjgrınn ve 
görsellerin internet ortamına taşınması basılı yayıncghjılıktakni 
tirajları da düşürmüştür. Gra�k Tasarımcıların çalışma alanlardan 
biriside gazetedir. Basılı yayının dijital alana yönelhhmghjgmesi 
tasarımcının işini olumlu yortamda devam ettihjmghmrebilmek-
tedir.  Gazetenin tarihi gelişiminde ilk olarak haber sayfaları taş, 
kilişimi sonucu baskı makineleriyle beraber tasarım dannnnn bu 
sürecGazeteler basılı olarak devam ettiği gibi aynı zamanda dijital 
ortamlarda hizmet vermektedir. Bunun yanı sıra haberi oluşturan 
yazıların ve görsellerin internet ortamına taşınması bası��nnnnlı 
yayıncılıktaki tirajları da düşürmüştür. Gra�k Tasahrımchhhhıların 
çalışma alanlardan biriside gazetedir. Basılı yayının dijital anlana 
yönelmesi tasarımcının işini olumlu yönde etkiler çünkü tasarımcı 
işini dijital ortamda devam ettirebilmektedir.

HABER BAŞLIĞI ALANI

 Günümüzde internetin yaygınlaşması her yerde olduğu gibi 
gazeteler üzerinde de etkisini göstermiştir. Gazeteler basılı 
olarak devam ettiği gibi aynı zamanda dijital ortamlarda hizmet 
vermektedir. Bunun yanı sıra haberi oluşturan yazıların ve 
görsellerin internet ortamına taşınması basılı yayıncılıktaki 
tirajları da düşürmüştür. Gra�k Tasarımcıların çalışma alanlardan 
biriside gazetedir. Basılı yayının dijital alana yönelmesi 
tasarımcının işini olumlu yönde etkiler çünkü tasarımcı işini 
dijital ortamda devam ettirebilmektedir.        
  Gazetenin tarihi gelişiminde ilk olarak haber sayfaları taş, kil 
gibi malzemelerin üzerine kazınarak kullanılırken sonraları 
papirüs ve parşömen üzerine yazılmıştır. Matbaanın geliş icadı 
ile har�er elle yan yana dizilerek bir düzen içinde daha fazla 
sayıda sayfa okuyucuya ulaştırılmıştır. Teknolojinin sürekli olarak 
gelişimi sonucu baskı makineleriyle beraber tasarım da bu 
sürece dâhil edilmiştir. 
  

     Gazetenin tarihini öğreniy 
gelişiminde ilk olarak haberi 
sayfaları taş, kil giıoıooioobiı 
malzemelerin üzesridsdsdne 
kazınarak kullanılırcdssskenk 
sonraları papirüsaaaaaaa ve 
parşömen üzeriyazılmıştgır. 

        Gazetenin tarihi gelişiminde ilk olarak 
haber sayfaları taş, kil gibi malzemelerin 
üzerine kazınarak kullanılırken sonraları 
papirüs ve parşömen üzerine yazılmıştır. 
Matbaanın geliş icadı ile har�er elle yan 
yana dizilerek bir düzen içinde daha fazla 
sayıda sayfa okuyucuya ulaştırılmıştır. 
Teknolojinin sürekli olarak gelişimisonucu 
baskı makineleriyle beraber tasarım da bu 
sürece dâhil edilmiştir. 
        Günümüzde internetin yaygınlaşması 
her yerde olduğu gibi gazeteler üzerinde 
de etkisini göstermiştir. Gazeteler basılı 
olarak devam ettiği gibi aynı zamanda 
dijital ortamlarda hizmet vermektedir. 
Bunun yanı sıra haberi oluşturan yazıların 
ve görsellerin internet ortamına taşınması 
basılı yayıncılıktaki tirajları da üşürmüştür. 
Gra�k Tasarımcıların çalışma alanlardan 
biriside gazetedir. Basılı yayının dijital 
alana yönelmesi tasarımcının işini olumlu 
yönde etkiler  Gazetenin tarihigelişiminde 
ilk olarak haber sayfalail gibimalzemelerin 
üzerine kazınarak kullanılırken sonraları 
papirüs vparşömen üzerine yazılmıştır. 
Matbaanın geliş icadı ile har�er elle yan 

        Gazetenin tarihi gelişiminde ilk olarak 
haber sayfaları taş, kil gibi malzemelerin 
üzerine kazınarak kullanılırken sonraları 
papirüs ve parşömen üzerine yazılmıştır. 
Matbaanın geliş icadı ile har�er elle yan 
yana dizilerek bir düzen içinde daha fazla 
sayıda sayfa okuyucuya ulaştırılmggıştır. 
Teknolojinin sürekli olarak gelişiggggmi 
sonucu baskı makineleriyle beraggggber 
tasarım da bu sürece dâhil egggdilmiştir. 
        Günümüzde internetin yaygınlaşması 
her yerde olduğu gibi gazeteler üzerinde 
de etkisini göstermiştir. Gazeteler basılı 
olarak devam ettiği gibi aynı zamgganda 
dijital ortamlarda hizmet vermektggedir. 
Bunun yanı sıra haberi oluşturan yazıların 
ve görsellerin internet ortaggggggmına 
taşınması basılı yayıncılıktaki tirajları da d

        
Gazetenin tarihi gelişiminde ilk 
olarak haber sayfaları taş, kilkk 
gibi malzemelerin üzerikgkkne 
kazınarak kullanılırken sonraları 
papirüs ve parşömen üzerihne 
yazılmıştır. Matbaanın gelişkk 
icadı ile har�er elle yan yan9ka 
dizilerek bir düzen içinde daha 
fazla sayıda sayfa okuyucuyha 
ulaştırılmıştır. Teknolojikkknin 
ksürekli olarak gelişimi sonucu 
baskı makineleriyle berabhher 
tasarım da bu sürece dâhikkl 
edilmiştir.hhhkloşioyuoooşıoı 
        Günümüzde internetihhn 
yaygınlaşması her yerdeolduğu 
gibi gazeteler üzerinde de 
etkisini göstermiştir. Gazeteler 
basılı olarak devam ettiği gibi 
aynı zamanda dijital ortamlarda hizmet vermektedir. Bunun yanı sıra haberi 
oluşturan yazıların ve görsellerin internet ortamına taşınması basıkkkkkklı 
kkkkyayıncılıktaki tirajları da düşürmüştür. Gra�k Tasarımcılarkkkkkkkkkın 
çalışmkkkkka alanlardan biriside gazetedir. Basılı yayının dijitalkkkkk alana 

        Gazetenin tarihi gelişiminde ilk olarak haber sayfaları taş, kil gibighjg 
malzemelerin üzerine kazınarak kullanılırken sonraları papirüs veghjghhjk 
parşömen üzerine yazılmıştır. Matbaanın geliş icadı ile har�er elle yandfgh 
yana dizilerek bir düzen içinde daha fazla sayıda sayfa okuyucuyafyjhjzdfg 
ulaştırılmıştır. Teknolojinin sürekli olarak gelişimi sonucu baskmakineCleri-

yleberabertasarım 
da bu sürecefCtyj 
edilmiştir. 
        Günümüzde 
internetiCnaygıd-
�aşmbasılı olarXak 
devamvermCekte-
dir. Bunun yanı sıra 
haberi oluşturXan 
yazılarıngörsellerin 
internet ortamCına 
taşınması baVVVsılı 
yrgterertmjklVjkjk-
takilardüşürmüştür. 
Gra�kTasarımcıların 
çalışma alanlardan 

biriside gazetedir. Basılı yayının dijital alana yönelmesi tasarımcının işinifg 
olumlu yönde etkiler çünkü tasarımcı işini dijital ortamda devam ettiresdg 
Gazetenin tarihi gelişiminde ilk olarak haber sayfaları taş, kil gibmalzemel-
erin üzerine kazınarak kullanılırken sonraları papirüs ve prşzerinyazılmıştır. 
Matbaanın aynı zamanda dijital ortamlarda hizmet vermektedir. Bunun 
yanı sıra lskefşeli  sdş�sşdl,�l isdifşlişclvb mlşsd�   iaşlsd�şl .şas asşld   aşs� 
a şşaiş fş  fkakwjıwjkzsd   akdfakefrl iaşerği awdk amfqwu    ak�akal  ak�  
awdka ak aw şoawr aşlrwo,Fi ğ isefşi  ielr ,iğwerşl aieşr şliş işawer liserl şlser 
ll.selr şişer ilwieşlirşl il  lswiseşli şlisşelrş şlişaelr liwşelr  sese drsr sewe se

        Gazetenin tarihi gelişiminde ilk olarVVVVak 
haber sayfaları taş, kil gibi malzemelerin üzerine 
kazınarak kullanılırken sonraları papirBBBüs ve 
parşömen üzerine yazılmıştır. Matbaanın geliş 
icadı ile har�er elle yan yana dizilerek bir düzen 
içinde daha fazla sayıda sayfa okuyucBBBBuya 
ulaştırılmıştır. Teknolojinin sürekli olVVVVVarak 
gelişimi sonucu baskı makineleriyle beVVraber 
tasarım da bu sürece dâhil edilmiştir. 
        Günümüzde internetin yaygınlaşması Vher 
yerde olduğu gibi gazeteler üzerinde de etkisini 
göstermiştir. Gazeteler basılı olarak devbbbbam 
ettiği gibi aynı zamanda dijital ortambbbblarda 
hizmet vermektedir. Bunun yanı sıra bbbhaberi 
oluştur        Gazetenin tarihi gelişimbbbbinde ilk 
olarak haber sayfaları taş, kil gibi malzemelerin 
üzerine kazınarak kullanılırken sonraları papirüs 
ve parşömen üzerine yazılmıştır. MaVVtbaanın 
geliş icadı ile har�er elle yan yana diVzilerek bir 
düzen içinde daha fazla sayıda sayfa okuyucuya 
ulaştırılmıştır. Teknolojinin sürekli bbbbbolarak 
gelişimi sonucu baskı makineleriyle berVVaber 
tasarım da bu sürece dâhil edibbbbbbbblmiştir. 
        Günümüzde internetin yaygınlaşması her 
yerde olduğu gibi gazeteler üzerinde de etkisini 
göstermiştir. Gazeteler basılı olabbbrak devam 
ettiği gibi aynı zamanda dijital ortbbbbamlarda 
hizmet vermektedir. Bunun yanı sıra hVabebbri 
oluşturan yazıların ve görsellerin intbbbVbber-
net ortamına taşınması basılı yayıncılıVktbbbaki 
tirajları da düşürmüştür. Gra�k Tasarımbcıların 

        Gazetenin tarihi gelişiminde ilk olarak 
haber sayfaları taş, kil gibi malzemjjjelerin 
üzerine kazınarak kullanılırken sojjjjnraları 
papirüs ve parşömen üzerine yazıljjmıştır. 
Matbaanın geliş icadı ile har�er ellejjj yan 
yana dizilerek bir düzen içinde daha fazla 
sayıda sayfa okuyucuya ulaştırılmjjıjjjjjştır. 
Teknolojinin sürekli olarak gelişimi sonucu 
baskı makineleriyle beraber tasarım da bu 
sürece dâhil edilmiştir. 
        Günümüzde internetin yaygınlaşması 
her yerde olduğu gibi gazeteler üzerinde 
de etkisini göstermiştir. Gazeteler bjjjjasılı 
olarak devam ettiği gibi aynı zamajjjjjnda 
dijital ortamlarda hizmet vermektedjjjjjjir. 
Bunun yanı sıra haberi oluşturan yajzıların 
ve görsellerin internet ortamına taşınması 
basılı yayıncılıktaki tirajları da düşürmüştür. 
Gra�k Tasarımcıların çalışma alanlardan 

HABER BAŞLIĞI
HABER BAŞLIĞI

HABER BAŞLIĞIHABER BAŞLIĞI

HABER BAŞLIĞI

Gazetenin tarihi gelişiminde ilk olarak haber sayfaları taş, kil gibi malzemelerinin 
üzerine kazınarak kullanılırken sonraları papirüs ve parşömen üzerine yazılmnnıjştır. 
Matbaanın geliş icadı ile har�er elle yan yana dizilerek bir düzen içindevvv jjndaha
azla sayıda sayfa okuyucuya ulaştırılmıştır. Teknolojinin sürekli olarak gelişijjminnin 
sonucu baskı makineleriyle bvvvvvvverab  gazete gazete gazete oku gazete okuy
tasarım da bu sürece dâhil edilmiştir. Günümüzde internetin yaygınlaşması herkes 

yerde olduğu gibi gazeteler üzderinde de etkisini 
göstermiştir. Gazeteler basılı olarak devam ettiğini 
gibi aynı zamanda dijital ortamlarda hizmetlilerrle 
vermektedir. Bunun yanı sıra haberi oluştujjjjjjjran 
yazıların ve görsellerin internet ortamına gelirlejjr 
taşınması yayıncılıktaki tirajları da düşürmüjjşjjtür. 
Gra�k Tasarımcıların çalışma alanlardan birisjjjjjide 
gazetedir. BaGsılı yayınıdijital alana yönelmesinin 
tasarımcının işini olumlu yönde etkiler çünkü sen 
tasarımcı işinGi dijital ortamda devam etmelidirler. 
ettirebilmektedir. Gazetenin tarihi gelişiminde ilk 
olarak habccdder sayfaları taş, kil gibi er elle yan  
devam ettirebilmektedir.

   5devam ettiği gibi aynı zamanda dijital ortamlarda 
hizmet vermektedir. Bunun yanı sıra haberi oluşturan 
yazıların ve görsellerin internet ortamına taşınBması 
basılı yayıncılıktaki tirajları da düşürmüştür. GraBB�k 
Tasarımcıların çalışma alanlardan biriside gazetediBr. 
Basılı yayının dijital alana yönelmesi tasarımcının işini 
olumlu yönde etkiler çünkü tasarımcı i
şini dijital ortamda devam ettirebilmektBBBBBBedir.        
Gazetenin tarihi gelişiminde ilk olarak haber sayfaları 
taş, kil gibi malzemelerin üzerine kazınaraBBBBBBBk 
kullanılırXXXXXXken XXsonraları papirBBBBBBBBs ve 
parşömen üzerine yazılmıştır. Matbaanın geliş icadı 
ile har�er elle yan yana dizilerek bir düzen içinBBde 
daha fazla sayıda sayfa okuyucuya ulaştırılmışBBtır. 
Teknolojinin sürekli olarak gelişimi sonucu basBBkı 
makineleriyle beraber tasarım da bu sürece dBBâhil 

HABER BAŞLIĞI
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HABER BAŞLIĞI

HABER BAŞLIĞI

HABER BAŞLIĞI

HABER BAŞLIĞI

LOGO

GÖRSEL ALANI

GÖRSEL ALANI

GÖRSEL ALANI

GÖRSEL ALANI

GÖRSEL ALANI

Gazete sayfası tasarımlarında genellikle 344 x 525 mm'lik sayfa ölçülerinde 9 sü-
tunluk planlar kullanılır. Mizanpaj programında sütunlara bölme işlemi, program 
açıldığında ekrana gelen karşılama ekranında bulunan Create New bölümündeki 
Document tıklanarak yapılır (Görsel 2.2). Aynı zamanda File > New > Document 
yolu izlenerek açılan New Document penceresindeki Columns bölümünden de 
yapılır. 

Görsel 2.2: Gazete sayfası ölçülerinde yeni doküman oluşturma
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Sayfa unsurlarının ortalama %80'ini oluşturan metinlere dikkat çekmek ve 
bunların birbirlerinden ayrılmalarını sağlamak için bazı yöntemler kullanılır. 

	● Uzun metinlerde tırnaklı yazı karakterlerinin okunması, devam eden 
bir satır gibi görünmesi nedeniyle daha kolaydır. Bu açıdan haber 
metinlerinde tırnaklı karakterlerin kullanılması uygun olur. Altı çizgili, 
üstü çizgili, gölgeli, konturlu biçimlendirmelerden kaçınılmalı; kalın ve 
italik biçimlendirmeler vurgulama için kullanılmalıdır (Görsel 2.3). 

Görsel 2.3: Yazı biçimlendirme 

	● Haber metinlerinin karakter büyüklüğünde genel olarak 10 punto 
tercih edilir. Yazıyı sayfa içinde belirli bir alana yerleştirebilmek için 
punto değerinin çok fazla büyütülmesi veya küçültülmesinden kaçı-
nılmalıdır. 9,5-10,5 aralığı uygun olur. Gazete sayfalarında harf ve 
satır aralıkları da genellikle daraltılır. Harf aralıklarında çoğunlukla -3 
değeri kullanılırken satır aralığı, kullanılan puntonun 1 değer yukarı-
sıdır (Görsel 2.4).

Görsel 2.4: Mizanpaj programı karakter açılır penceresi
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	● Haber metinlerinin bloklanması; habere, metnin uzunluğuna, konumu-

na, spot kullanımına göre değişiklik gösterir ancak genellikle tam blok-
lama tercih edilir. 

	● Spotlar, genellikle başlıktan sonra gelen haber ayrıntılarıdır. Habe-
ri özetleme ve okutma işlevi dışında sayfanın düzenlenmesinde de 
önemli rol oynar. Yine haber metninde olduğu gibi tırnaklı karakterler 
tercih edilmeli ancak puntosu biraz daha büyük olmalıdır. Genellikle 12 
punto tercih edilir. 

	● Haber metni zemininde fotoğraf kullanımı tercih edilebilir. Resim altı 
olarak adlandırılan uygulamada metin; fotoğraf genişliğinde, kalın ve 
haber metninden daha küçük puntolarda kullanılır. Okunurluğun bozul-
mamasına dikkat edilmelidir.

	● Başlıklar, dikkat çekmesi için genellikle kalın karakterle ve siyah renkte 
yazılır. Başlıklar için önceden belirlenen birkaç yazı karakteri kullanıl-
malı, çok fazla karakter çeşidinden kaçınılmalıdır. Başlık, haber metni 
sütunu ile aynı genişlikte olmalı; o başlık altında başka haber bulun-
mamalıdır. Başlıklar en fazla üç satır olmalı ve genişlikleri mümkün 
olduğunca eşit tasarlanmalıdır. Uzun metinlerde durağanlığı gidermek 
amacıyla ara başlıklar kullanılabilir. Bu ara başlıklar genellikle büyük 
harflerle tek satır, puntosu haber metninden biraz büyük olarak kulla-
nılır. 

Görseller, haberi desteklemenin yanında yazı yoğunluğunu azaltır; durağan-
lığı gidererek de sayfa düzenlemesine yardımcı olur. Gazetelerin düzenleme 
anlayışına göre farklı uygulamaları bulunsa da yaygın olarak kullanılan bazı 
kuralları vardır. 

	● Fotoğraflar, okuyucuların sayfada dikkatini çeken ilk unsurlardır. Fotoğ-
rafların haberle ilgili bir anlam taşımasına ve belge niteliğinde olması-
na dikkat edilmelidir. Netlik, ışık dengesi, kadraj gibi teknik özelliklerin 
uygun olması ve özellikle istenmedikçe üzerinde oynama yapılmamış 
olması gereklidir. Konunun öne çıkarılması amacıyla kesme, arka plan 
temizleme, sayfaya uyması için çevirme gibi işlemler yapılabilir. 

	● Yan yana gelen portrelerin aynı ebatta olmasına özen gösterilmelidir. 
Portre fotoğraflarının küçük, içinde çok sayıda obje bulunan geniş alan 
fotoğraflarının büyük ebatta kullanımı uygundur.

	● Fotoğraf yoksa haberi desteklemek amacıyla grafik ve illüstrasyonlar 
kullanılabilir. Bu durumlarda fotoğraf kullanımı için uygulanan kurallar 
bu görseller için de geçerlidir.

	● Görsellerin basıma uygun çözünürlükte ve sonradan sürprizlerle karşı-
laşmamak için CMYK modunda olmasına dikkat edilmelidir. 

	● Görsellerin sayfaya dengeli bir şekilde dağıtılması, hangi habere ait ol-
duğunun ilk bakışta anlaşılacak şekilde konumlandırılması ve boyutlan-
dırılması önemlidir. 
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Metin ve görsellerin daha kolay algılanmasını sağlamak, durağanlığı bozmak, 
sayfayı renklendirmek ve rahatlatmak amacıyla renk, çizgi, çerçeve gibi yardımcı 
tasarım elemanlarından faydalanılabilir. Bu elemanlar kullanılırken elemanların 
her haberde kullanılmamasına, sayfada dengeli bir şekilde dağıtılmasına, çok 
çeşitli renklerde kullanılmamasına, görsellerin etkisini azaltmamasına ve okunur-
luğu güçleştirmemesine dikkat edilmelidir. Metin, görsel ve tasarım elemanları 
arasında bırakılan beyaz boşlukların da diğerleri kadar önemli olduğu ve dikkatli 
bir şekilde kullanılması gerektiği unutulmamalıdır (Görsel 2.5, 2.6). 

 Görsel 2.5: Mizanpaj programında haber sayfası tasarımı

Görsel 2.6: Haber sayfası şablonu
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2 Şekil 2.1’in içine dört haber alanı ve bir reklam alanı olacak şekilde gazete 
sayfası şablonu oluşturunuz. 

Sınıf arkadaşlarınızla paylaşım yaparak çeşitli yayın kuruluşlarının gazete-
lerini alınız. Gazetelerdeki iç sayfa haberlerini aşağıda verilenler açısından 
inceleyiniz. Düzenlemelerle ilgili notlar alarak sınıfta paylaşınız.

•	 Sütunlar ve birleşim şekilleri 
•	 Sayfaların yeri değişmeyen sayfa 
	 numarası, logosu ve tarih gibi unsurları 
•	 Haber başlıkları 
•	 Metinler 
•	 Görseller 
•	 Spotları ve sayfada yerleşimleri
•	 Reklam alanları

Şekil 2.1
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ÖĞRENME BİRİMİ: GAZETE SAYFASI HAZIRLAMA 
UYGULAMA ADI  : Haber Sayfası Hazırlama
AMAÇ		       : Haber sayfasını mizanpaj programında hazırlamak. 

Araç Gereç
1.	 Bilgisayar
2.	 Tarayıcı
3.	 Grafik tasarım programları
4.	 İnternet

Aşağıdaki işlem basamaklarını dikkate alarak bir gazetenin haber 
sayfasını düzenleyiniz. 

İşlem Basamakları
1.	 Atölye önlüğünüzü giyiniz; araç gerecinizi, çalışma alanınızı iş 

sağlığı ve güvenliği tedbirlerini alarak özenle hazırlayınız.
2.	 Bilgisayarı çalışmaya hazır hâle getiriniz. 
3.	 Çalışırken oturma pozisyonunuza dikkat ediniz, yanlış oturuş 

şekli sağlığınız için zararlıdır. 
4.	 34,4 x 52,5 cm ölçülerinde 9 sütunluk bir çalışma sayfası açınız. 
5.	 Sayfanın sol altında 26 x 40 cm boyutlarında reklam alanı ayar-

layınız.
6.	 Konunuza uygun haber metinlerini ve görselleri toplayınız.
7.	 Dosyayı bilgisayarda uygun yere, mizanpaj programının kendi 

formatında kaydediniz.
8.	 Başlık ve metinlerin karakter ve büyüklüklerini özenle belirleyiniz.
9.	 Kullanılacak görselleri teknik açıdan uygun hâle getiriniz.
10.	Çalışmanız süresince sabırlı ve dikkatli olmaya özen gösteriniz.
11.	 Çalışmanızı hem paket olarak hem de PDF formatında kayde-

diniz. 
12.	Çalışmanızın A3 boyutlarında çıktısını alarak sayfalarını kontrol 

ediniz. 

DEĞERLENDİRME
Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. 
Çalışmanız, Ek 1’de verilen “Değerlendirme Formu” ve “Kontrol Liste-
si ”ndeki ölçütlere göre değerlendirilecektir. Çalışmanızı yaparken bu 
ölçütleri dikkate alınız. 
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2.1.2. Ekonomi Sayfası
Ekonomik gelişmeler toplumun her kesimini ilgilendirdiği için gazetelerin ekonomi 
sayfaları önemli bir yere sahiptir. Bu yüzden büyük gazetelerin ekonomi servisleri 
bu konuda uzmanlaşmış personellerden oluşur. Gazetelerde ekonomi sayfaları, 
genellikle ayrı bir bölüm olarak düzenlenir; finans, borsa vb. başlıklar altında ayrı 
bir iç düzenleme ile hazırlanır. Gazetelerin yayın politikasına bağlı olarak ekonomi 
sayfalarının sayısı değişkenlik gösterir ancak ortalama olarak gazetenin toplam 
sayfa sayısının altıda biri kadardır. 

Günümüzde fotoğraf, grafik, tablo, sabit köşe ve ilanların çok kullanıldığı ekonomi 
sayfaları oldukça dinamik ve hareketli sayfa tasarımlarına sahiptir. Diğer bölümler-
den ayrılmaları için genellikle ayrı tasarlanmış logolara sahiplerdir. Sayfa düzenle-
meleri yapılırken bu logoların ve altın, döviz, borsa gibi günlük değişkenlik göste-
ren unsurların yerlerinin değiştirilmemesine özen gösterilmelidir (Görsel 2.7, 2.8). 
Bunlar, okuyucuların çoğu için hızlı ulaşılmak istenen önemli bilgilerdir. Ekonomi 
haberleri içinde yapılabilecek en ufak rakam hataları bile büyük yatırım kayıplarına 
neden olabilir. Hukuki sıkıntılara da sebep olabileceği düşünülürse neden çok dik-
katli olunması gerektiği daha iyi anlaşılır.

Görsel 2.7: Mizanpaj programında ekonomi sayfası 
tasarımı

Görsel 2.8: Ekonomi sayfası şablonu
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Sınıf arkadaşlarınızla paylaşım yaparak çeşitli yayın kuruluşlarının gazete-
lerini alınız. Gazetelerdeki ekonomi sayfalarını aşağıda verilenler açısından 
inceleyiniz. Düzenlemelerle ilgili notlar alarak sınıfta paylaşınız.

•	 Sütunlar ve birleşim şekilleri 
•	 Sayfaların yeri değişmeyen sayfa 
	 numarası, logosu ve tarih gibi unsurları 
•	 Haber başlıkları 
•	 Metinler 
•	 Görseller 
•	 Spotları ve sayfada yerleşimleri
•	 Reklam alanları 
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4 Şekil 2.2’nin içine bir ekonomi sayfası şablonu çiziniz. 

Şekil 2.2
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ÖĞRENME BİRİMİ: GAZETE SAYFASI HAZIRLAMA
UYGULAMA ADI  : Ekonomi Sayfası Hazırlama
AMAÇ		      : Ekonomi sayfasını mizanpaj programında hazır-   	
	                    lamak. 

Araç Gereç
1.	 Bilgisayar
2.	 Tarayıcı
3.	 Grafik tasarım programları
4.	 İnternet

Aşağıdaki işlem basamaklarını dikkate alarak bir gazetenin eko-
nomi sayfasını iki sayfa hâlinde yeniden düzenleyiniz.

İşlem Basamakları
1.	 Atölye önlüğünüzü giyiniz; araç gerecinizi, çalışma alanınızı iş 

sağlığı ve güvenliği tedbirlerini alarak özenle hazırlayınız.
2.	 Bilgisayarı çalışmaya hazır hâle getiriniz. 
3.	 Standart gazete sayfası ölçülerinde 9 sütunluk bir çalışma say-

fası açınız.
4.	 Dosyayı bilgisayarda uygun yere, mizanpaj programının kendi 

formatında kaydediniz.
5.	 Sayfanıza logo, reklam, tablo ve yaptığınız düzenlemenin ge-

rektirdiği sabit unsurları yerleştiriniz.
6.	 İkinci sayfanın altına 33,4 x 7 cm boyutlarında bir reklam yerleş-

tiriniz.
7.	 Konunuza uygun haber metinlerini ve görselleri toplayınız.
8.	 Başlık ve metinlerin karakter ve büyüklüklerini özenle belirleyiniz.
9.	 Kullanılacak görselleri teknik açıdan uygun hâle getiriniz.
10.	Çalışmanız süresince sabırlı ve dikkatli olmaya özen gösteriniz.
11.	 Çalışmanızı hem paket olarak hem de PDF formatında kayde-

diniz. 
12.	Çalışmanızın A3 boyutlarında çıktısını alarak sayfalarını kontrol 

ediniz. 

DEĞERLENDİRME
Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. 
Çalışmanız, Ek 1’de verilen “Değerlendirme Formu” ve “Kontrol Liste-
si ”ndeki ölçütlere göre değerlendirilecektir. Çalışmanızı yaparken bu 
ölçütleri dikkate alınız. 
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2.1.3. Kültür Sanat Sayfası
Kültür sanat konuları ile ilgili yayın organları incelendiğinde bunlarda konu içeriğinin de etkisiyle 
estetik kaygıların yüksek olduğu, görsellerin metinlerden fazla yer bulduğu, ilgi çekici ve dinamik 
düzenlemelerin olduğu görülür. Kültür sanat sayfaları veya bölümleri, her gazetede yer bulamasa 
da yayın politikası nedeniyle bu konuya önem veren gazetelerde ayrı bir bölüm olarak yer ala-
bilmektedir. Bu sayfalarda da diğer yayın organlarının ilgili bölümlerinde olduğu gibi estetik kay-
gısı yüksek, kaliteli görseller yoğun kullanılır. Kültürel veya sanatsal anlamda ilgi çekici, dinamik 
düzenlemelerin yapılmasına özen gösterilir. Kültür ve sanatla ilgili bir bölümde estetik kaygıların 
yüksek olması gayet normaldir. Konuya özgü bu özellikleri dışında kültür sanat sayfalarında ga-
zete sayfası tasarlama ile ilgili başlık, metin ve ölçülerle ilgili kurallara dikkat edilmelidir.

Kültür sanat sayfalarının diğer bölümlerden ayrılması için genellikle ayrı tasarlanmış logoları var-
dır. Bu logoların devamlı aynı yerde kullanılmasına özen gösterilmelidir. Birçok kültür sanat say-
fasında köşe yazılarının ve duyuru niteliğinde haberlerin yer aldığı sabit bölümler vardır. Bu bö-
lümlerin değiştirilmemesine ve aynı zamanda diğer haberler arasında kaybolmamasına da dikkat 
edilmelidir. Kültür sanat gündemi ile magazin gündeminin birbirine karıştırılmaması da gazetenin 
saygınlığı açısından dikkatten kaçırılmaması gereken önemli bir konudur (Görsel 2.9, 2.10). 

Görsel 2.9: Mizanpaj programında kültür sanat sayfa tasarımı

Görsel 2.10: Kültür sanat sayfası şablonu
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Sınıf arkadaşlarınızla paylaşım yaparak çeşitli yayın kuruluşlarının gazetelerini 
alınız. Gazetelerdeki kültür sanat sayfalarını aşağıda verilenler açısından ince-
leyiniz. Düzenlemelerle ilgili notlar alarak sınıfta paylaşınız.

•	 Sütunlar ve birleşim şekilleri 
•	 Sayfaların yeri değişmeyen sayfa 
	 numarası, logosu ve tarih gibi unsurları 
•	 Haber başlıkları 
•	 Metinler 
•	 Görseller 
•	 Spotları ve sayfada yerleşimleri
•	 Reklam alanları 
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6 Şekil 2.3’ün içine bir kültür sanat sayfası şablonu çiziniz. 

Şekil 2.3
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ÖĞRENME BİRİMİ: GAZETE SAYFASI HAZIRLAMA 
UYGULAMA ADI  : Kültür Sanat Sayfası Hazırlama
AMAÇ		       : Kültür sanat sayfasını mizanpaj programında 	
	                   hazırlamak. 

Araç Gereç
1.	 Bilgisayar
2.	 Tarayıcı
3.	 Grafik tasarım programları
4.	 İnternet

Aşağıdaki işlem basamaklarını dikkate alarak bir gazetenin kültür 
sanat sayfasını iki sayfa hâlinde yeniden düzenleyiniz.

İşlem Basamakları
1.	 Atölye önlüğünüzü giyiniz; araç gerecinizi, çalışma alanınızı iş 

sağlığı ve güvenliği tedbirlerini alarak özenle hazırlayınız.
2.	 Bilgisayarı çalışmaya hazır hâle getiriniz. 
3.	 Standart gazete sayfası ölçülerinde 9 sütunluk bir çalışma say-

fası açınız.
4.	 Dosyayı bilgisayarda uygun yere, mizanpaj programının kendi 

formatında kaydediniz.
5.	 Çalışırken oturma pozisyonunuza dikkat ediniz, yanlış oturuş 

şekli sağlığınız için zararlıdır.
6.	 Sayfanıza logo, reklam, tablo ve yaptığınız düzenlemenin ge-

rektirdiği sabit unsurları yerleştiriniz.
7.	 İkinci sayfanın altına 33,4 x 7 cm boyutlarında bir reklam yer-

leştiriniz.
8.	 Konunuza uygun haber metinlerini ve görselleri toplayınız.
9.	 Başlık ve metinlerin karakter ve büyüklüklerini özenle belirleyiniz.
10.	Kullanılacak görselleri teknik açıdan uygun hâle getiriniz.
11.	 Haberin yer alacağı alanı kabaca belirleyiniz.
12.	Uygun görsellerle birlikte başlık, spot ve haber metinlerini say-

faya yerleştiriniz.
13.	Çalışmanız süresince sabırlı ve dikkatli olmaya özen gösteriniz.
14.	Çalışmanızı hem paket olarak hem de PDF formatında kay-

dediniz. 
15.	Çalışmanızın A3 boyutlarında çıktısını alarak sayfalarını kontrol 

ediniz. 

DEĞERLENDİRME
Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. 
Çalışmanız, Ek 1’de verilen “Değerlendirme Formu” ve “Kontrol Liste-
si ”ndeki ölçütlere göre değerlendirilecektir. Çalışmanızı yaparken bu 
ölçütleri dikkate alınız. 
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2.1.4. Spor ve Magazin Sayfaları
Spor ve magazin haberleri, gazete sayfaları içinde en çok rağbet gören bölümler 
arasındadır. Bu yoğun ilgi nedeniyle gazeteler, bölümlerle yetinmeyip düzenli ola-
rak spor ve magazin ekleri de verebilmektedir. Bu nedenle her konuda önemli olan 
sunum, gazetelerin spor ve magazin bölümlerinde daha da özenilir bir hâl almıştır. 
Bu bölümlerin diğer bölümlerden ayrılması için farklı tasarlanmış logoları vardır. 
Örnekler incelendiğinde görselliğin ön planda olduğu, sayfaların renkli ve dinamik 
bir tasarımla oluşturulduğu, haber manşetlerine, fotoğraflarına, spotlarına hassasi-
yet gösterildiği rahatlıkla fark edilebilir. İlgi çekici başlıklar, kısa metinler ve sayfada 
hareketlilik sağlayacak şekilde dekupe edilerek kullanılan, manşetlerin arkasında 
veya spot olarak verilen, sayfa geneline göre yoğun kullanılan fotoğraflar dikkat 
çeker (Görsel 2.11, 2.12, 2.13). 

Görsel 2.11: Mizanpaj programında spor ve magazin sayfası tasarımı

Görsel 2.12: Spor sayfası şablonu  Görsel 2.13: Magazin sayfası şablonu
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Sınıf arkadaşlarınızla paylaşım yaparak çeşitli yayın kuruluşlarının gazetelerini 
alınız. Gazetelerdeki spor ve magazin sayfalarını aşağıda verilenler açısından 
inceleyiniz. Düzenlemelerle ilgili notlar alarak sınıfta paylaşınız.

•	 Sütunlar ve birleşim şekilleri 
•	 Sayfaların yeri değişmeyen sayfa 
	 numarası, logosu ve tarih gibi unsurları 
•	 Haber başlıkları 
•	 Metinler 
•	 Görseller 
•	 Spotları ve sayfada yerleşimleri
•	 Reklam alanları 
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8 Şekil 2.4’ün içine bir spor ve magazin sayfası şablonu çiziniz. 

Şekil 2.4
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ÖĞRENME BİRİMİ: GAZETE SAYFASI HAZIRLAMA 
UYGULAMA ADI  : Spor Sayfası Hazırlama
AMAÇ		       : Spor sayfasını mizanpaj programında hazırlamak. 

Araç Gereç
1.	 Bilgisayar
2.	 Tarayıcı
3.	 Grafik tasarım programları
4.	 İnternet

Aşağıdaki işlem basamaklarını dikkate alarak bir gazetenin spor 
sayfasını iki sayfa hâlinde yeniden düzenleyiniz. 

İşlem Basamakları
1.	 Atölye önlüğünüzü giyiniz; araç gerecinizi, çalışma alanınızı iş 

sağlığı ve güvenliği tedbirlerini alarak özenle hazırlayınız.
2.	 Bilgisayarı çalışmaya hazır hâle getiriniz. 
3.	 Standart gazete sayfası ölçülerinde 9 sütunluk bir çalışma say-

fası açınız.
4.	 Dosyayı bilgisayarda uygun yere, mizanpaj programının kendi 

formatında kaydediniz.
5.	 Çalışırken oturma pozisyonunuza dikkat ediniz, yanlış oturuş 

şekli sağlığınız için zararlıdır.
6.	 Sayfanıza logo, reklam, tablo ve yaptığınız düzenlemenin ge-

rektirdiği sabit unsurları yerleştiriniz.
7.	 İkinci sayfanın altına 33,4 x 7 cm boyutlarında bir reklam yer-

leştiriniz.
8.	 Konunuza uygun haber metinlerini ve görselleri toplayınız.
9.	 Başlık ve metinlerin karakter ve büyüklüklerini özenle belirleyiniz.
10.	Kullanılacak görselleri teknik açıdan uygun hâle getiriniz.
11.	 Haberin yer alacağı alanı kabaca belirleyiniz.
12.	Uygun görsellerle birlikte başlık, spot ve haber metinlerini say-

faya yerleştiriniz.
13.	Çalışmanız süresince sabırlı ve dikkatli olmaya özen gösteriniz.
14.	Çalışmanızı hem paket olarak hem de PDF formatında kay-

dediniz. 
15.	Çalışmanızın A3 boyutlarında çıktısını alarak sayfalarını kontrol 

ediniz. 

DEĞERLENDİRME
Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. 
Çalışmanız, Ek 1’de verilen “Değerlendirme Formu” ve “Kontrol Liste-
si ”ndeki ölçütlere göre değerlendirilecektir. Çalışmanızı yaparken bu 
ölçütleri dikkate alınız. 
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ÖĞRENME BİRİMİ: GAZETE SAYFASI HAZIRLAMA 
UYGULAMA ADI  : Magazin Sayfası Hazırlama
AMAÇ		       : Magazin sayfasını mizanpaj programında hazır-	
	                    lamak. 

Araç Gereç
1.	 Bilgisayar
2.	 Tarayıcı
3.	 Grafik tasarım programları
4.	 İnternet

Aşağıdaki işlem basamaklarını dikkate alarak bir gazetenin ma-
gazin sayfasını iki sayfa hâlinde yeniden düzenleyiniz.  

İşlem Basamakları
1.	 Atölye önlüğünüzü giyiniz; araç gerecinizi, çalışma alanınızı iş 

sağlığı ve güvenliği tedbirlerini alarak özenle hazırlayınız.
2.	 Bilgisayarı çalışmaya hazır hâle getiriniz. 
3.	 Standart gazete sayfası ölçülerinde 9 sütunluk bir çalışma say-

fası açınız.
4.	 Dosyayı bilgisayarda uygun yere, mizanpaj programının kendi 

formatında kaydediniz.
5.	 Çalışırken oturma pozisyonunuza dikkat ediniz, yanlış oturuş 

şekli sağlığınız için zararlıdır.
6.	 Sayfanıza logo, reklam, tablo ve yaptığınız düzenlemenin ge-

rektirdiği sabit unsurları yerleştiriniz.
7.	 İkinci sayfanın altına 33,4 x 7 cm boyutlarında bir reklam yer-

leştiriniz.
8.	 Konunuza uygun haber metinlerini ve görselleri toplayınız.
9.	 Başlık ve metinlerin karakter ve büyüklüklerini özenle belirleyiniz.
10.	Kullanılacak görselleri teknik açıdan uygun hâle getiriniz.
11.	 Haberin yer alacağı alanı kabaca belirleyiniz.
12.	Uygun görsellerle birlikte başlık, spot ve haber metinlerini say-

faya yerleştiriniz.
13.	Çalışmanız süresince sabırlı ve dikkatli olmaya özen gösteriniz.
14.	Çalışmanızı hem paket olarak hem de PDF formatında kay-

dediniz. 
15.	Çalışmanızın A3 boyutlarında çıktısını alarak sayfalarını kontrol 

ediniz.

DEĞERLENDİRME 
Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. 
Çalışmanız, Ek 1’de verilen “Değerlendirme Formu” ve “Kontrol Liste-
si ”ndeki ölçütlere göre değerlendirilecektir. Çalışmanızı yaparken bu 
ölçütleri dikkate alınız. 
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2.1.5. Arka Sayfa
Her gazetede kendine özgü bir sunuş biçimi geliştirilmeye çalışılır. Aynı zamanda 
gazete içindeki her bölümün de kendine has özellikleri vardır. Arka sayfa, gazete-
lerde birinci sayfadan sonra en çok görünen sayfa olduğu için ikinci bir vitrin olarak 
nitelendirilir. Bu nedenle  hem içerik hem de görsel açıdan çok önemlidir. 

Eskiden daha çok spor sayfası olarak kullanılan arka sayfalar, günümüzde çok 
çeşitli ve ilgi çekici haberlerin kullanıldığı bir bölüm olarak düzenlenmektedir. Çeşit-
lilik nedeniyle hareketli, dinamik bir yapıya sahiplerdir. Bazı gazetelerde genellikle 
logoya yakın olarak karikatür, hava durumu gibi sabit unsurlar da bulunur. Arka say-
fada, birinci sayfadakinden daha küçük olacak şekilde gazetenin logosu bulunur. 
Büyük ölçülerde hatta bazen tam sayfa reklamın olduğu arka sayfalar da vardır. 
Metin, başlık ve görsellerin teknik özellikleri gazete genelinde olduğu gibi arka say-
fada da yaygın kurallara uygun olarak belirlenmelidir (Görsel 2.14, 2.15). 

Görsel 2.14: Mizanpaj programında arka sayfa tasarımı

Görsel 2.15: Arka sayfa şablonu
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Sınıf arkadaşlarınızla paylaşım yaparak çeşitli yayın kuruluşlarının gazetele-
rini alınız. Bu gazetelerin arka sayfalarını aşağıda verilenler açısından ince-
leyiniz. Düzenlemelerle ilgili notlar alarak sınıfta paylaşınız.

•	 Sütunlar ve birleşim şekilleri 
•	 Sayfaların yeri değişmeyen sayfa 
	 numarası, logosu ve tarih gibi unsurları 
•	 Haber başlıkları 
•	 Metinler 
•	 Görseller 
•	 Spotları ve sayfada yerleşimleri
•	 Reklam alanları 
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K

11 Şekil 2.6’nın içine bir arka sayfa şablonu çiziniz.  

Şekil 2.6
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ÖĞRENME BİRİMİ: GAZETE SAYFASI HAZIRLAMA 
UYGULAMA ADI  : Arka Sayfa Hazırlama
AMAÇ		       : Arka sayfayı mizanpaj programında hazırlamak. 

Araç Gereç
1.	 Bilgisayar
2.	 Tarayıcı
3.	 Grafik tasarım programları
4.	 İnternet

Aşağıdaki işlem basamaklarını dikkate alarak bir gazetenin arka 
sayfasını yeniden düzenleyiniz.  

İşlem Basamakları
1.	 Atölye önlüğünüzü giyiniz; araç gerecinizi, çalışma alanınızı iş 

sağlığı ve güvenliği tedbirlerini alarak özenle hazırlayınız.
2.	 Bilgisayarı çalışmaya hazır hâle getiriniz. 
3.	 Çalışırken oturma pozisyonunuza dikkat ediniz, yanlış oturuş 

şekli sağlığınız için zararlıdır.
4.	 Sayfanıza logo, reklam, tablo ve yaptığınız düzenlemenin ge-

rektirdiği sabit unsurları yerleştiriniz.
5.	 Konunuza uygun haber metinlerini ve görselleri toplayınız.
6.	 Başlık ve metinlerin karakter ve büyüklüklerini özenle belirle-

yiniz.
7.	 Kullanılacak görselleri teknik açıdan uygun hâle getiriniz.
8.	 Uygun görsellerle birlikte başlık, spot ve haber metinlerini say-

faya yerleştiriniz.
9.	 Çalışmanız süresince sabırlı ve dikkatli olmaya özen gösteriniz.
10.	Çalışmanızı hem paket olarak hem de PDF formatında kay-

dediniz. 
11.	 Çalışmanızın A3 boyutlarında çıktısını alarak sayfalarını kontrol 

ediniz. 

DEĞERLENDİRME
Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. 
Çalışmanız, Ek 1’de verilen “Değerlendirme Formu” ve “Kontrol Liste-
si ”ndeki ölçütlere göre değerlendirilecektir. Çalışmanızı yaparken bu 
ölçütleri dikkate alınız. 
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2.1.6. İlan ve Reklam Sayfaları
Gazetelerde sadece ilan ve reklamların yer aldığı sayfalar düzenli olarak bulunur. 
İş, alım satım, kayıp, vefat ilanı gibi çok çeşitli ilanların yer aldığı bu bölümler ge-
nellikle metin ağırlıklıdır. Özellikle ticari amaçla eklenen reklamlar görsel ağırlıklı 
olabilir. İlanlar, sayfalarda sütun ve yükseklik ölçüsüne göre fiyatlandırıldığı için 
sayfa düzenlemeleri de bu ölçülere göre organize edilir (Görsel 2.16). 

İlan sayfalarının düzenlenmesinde dikkat edilmesi gereken en önemli unsur, oku-
yucuların aradığı ilanı rahatlıkla bulabilmeleridir. Bunun sağlanabilmesi için ilanlar, 
çeşitli ana ve gerekirse alt kategoriler şeklinde organize edilmelidir. Bu kategoriler, 
ufak simgelerle başlıklandırılabilir; böylece diğer ilan gruplarından ayrılarak okuyu-
cu tarafından rahatlıkla bulunabilir. 

Seri ilan sayfaları diğer sayfalardan farklı olarak standart gazete sayfalarında 10 
veya 11 sütun şeklinde de düzenlenebilir. İlanlar, sade olur ve belirli standartlara 
göre verilir. İlan verenin isteklerine göre bazı vurgulama seçenekleri olabilir ancak 
bunlar gazete sayfa düzeninin genel yapısına aykırı olmamalıdır. Metin ve başlık-
lar gazetenin geneline göre daha küçük kullanılır. 

Görsel 2.16: İlan ve reklam sayfası tasarımı
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Sınıf arkadaşlarınızla paylaşım yaparak çeşitli yayın kuruluşlarının gaze-
telerini alınız. Gazetelerdeki ilan ve reklam sayfalarını aşağıda verilenler 
açısından inceleyiniz. Düzenlemelerle ilgili notlar alarak sınıfta paylaşınız.

•	 Sütunlar ve birleşim şekilleri 
•	 Sayfaların yeri değişmeyen sayfa 
	 numarası, logosu ve tarih gibi unsurları 
•	 Başlıklar
•	 Metinler 
•	 Görseller 
•	 Spotları ve sayfada yerleşimleri
•	 Reklam alanları 
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13 Şekil 2.7’nin içine bir ilan ve reklam sayfası şablonu çiziniz.  

Şekil 2.7
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ÖĞRENME BİRİMİ: GAZETE SAYFASI HAZIRLAMA 
UYGULAMA ADI  : İlan ve Reklam Sayfası Hazırlama
AMAÇ		       : İlan ve reklam sayfasını mizanpaj programında 	
	                     hazırlamak. 

Araç Gereç
1.	 Bilgisayar
2.	 Tarayıcı
3.	 Grafik tasarım programları
4.	 İnternet

Aşağıdaki işlem basamaklarını dikkate alarak mizanpaj progra-
mında ilan ve reklam sayfası düzenleyiniz.   

İşlem Basamakları
1.	 Atölye önlüğünüzü giyiniz; araç gerecinizi, çalışma alanınızı iş 

sağlığı ve güvenliği tedbirlerini alarak özenle hazırlayınız.
2.	 Bilgisayarı çalışmaya hazır hâle getiriniz. 
3.	 Standart gazete sayfası ölçülerinde 10 sütunluk bir çalışma 

sayfası açınız.
4.	 Dosyayı bilgisayarda uygun yere, mizanpaj programının kendi 

formatında kaydediniz.
5.	 Çalışırken oturma pozisyonunuza dikkat ediniz, yanlış oturuş 

şekli sağlığınız için zararlıdır.
6.	 Sayfanıza varsa logo, reklam, tablo ve yaptığınız düzenlemenin 

gerektirdiği sabit unsurları yerleştiriniz.
7.	 Kategorilerine uygun görselleri toplayınız.
8.	 Başlık ve metinlerin karakter ve büyüklüklerini özenle belirleyiniz.
9.	 Haberin yer alacağı alanı kabaca belirleyiniz.
10.	 İlan ve reklamlarınızı uygun boyutlarda, kategoriler hâlinde say-

fanıza yerleştiriniz. 
11.	 Çalışmanız süresince sabırlı ve dikkatli olmaya özen gösteriniz.
12.	Çalışmanızı hem paket olarak hem de PDF formatında kayde-

diniz. 
13.	Çalışmanızın A3 boyutlarında çıktısını alarak sayfalarını kontrol 

ediniz. 

DEĞERLENDİRME
Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. 
Çalışmanız, Ek 1’de verilen “Değerlendirme Formu” ve “Kontrol Liste-
si ”ndeki ölçütlere göre değerlendirilecektir. Çalışmanızı yaparken bu 
ölçütleri dikkate alınız. 
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Görsel 2.17: Gazete sayfasında gözün 
hareketi

BİLGİ NOTU
Holmqvist (Holmküest) 
ve Wartenberg’ün (Vo-
rınbörg) (2005: 4) ger-
çekleştirdiği araştırma 
sonucuna göre göz, 
Görsel 2.17’de görü-
len düzlemde hareket 
etmektedir. Bu, elbette 
sadece soldan sağa 
doğru okunan alfabeler 
için geçerli bir durum-
dur.

2.2. GAZETEDE BİRİNCİ (ÖN) SAYFA TASARIMI  
Masaüstü yayıncılığın her alanında olduğu gibi gazete tasarımında da asıl amaç, 
gazetede yayımlanan haber ve reklamların okuyucuya doğru ve direkt ulaşma-
sını sağlamaktır. Gazete tasarımı, okuyucunun gazetede yayımlanan haberlere 
ve reklamlara önem sırasına göre en az çabayla ulaşmasını sağlayan en önemli 
unsurdur. Gazetenin yüzü olarak nitelendirilen ilk sayfa da bu kriterler baz alınarak 
tasarlanır. Gazetenin yayın politikasını, kurumsal kimliğini ve hedef kitlesini en iyi 
yansıtacak tasarım birinci sayfada kendini göstermelidir.

Birinci sayfa tasarımı, tüm gazete sayfa tasarımları bittikten sonra yapılır. Bunun 
nedeni iç sayfalarda yer alan içeriğin ve konu başlıklarının okuyucunun dikkatini 
çekmek amacıyla özet olarak ilk sayfada verilmesi ve iç sayfa numaralarını gös-
terilmesidir. 
Birinci sayfa tasarımında dikkat edilmesi gerekenler şunlardır:  

	● Diğer gazetelerden farklı bir tasarım olmalıdır.
	● Okuyucunun dikkatini çeken, çarpıcı bir tasarım olmalıdır.
	● Akılda kalıcı bir tasarım olmalıdır.
	● Kullanılan font ve punto okunaklı olmalıdır.
	● Tasarım unsurları, gazetenin kurumsal kimliğini yansıtmalıdır.
	● Gazetenin kurumsal kimliğine uygun renk kullanılmalıdır.
	● Kullanılan görseller doğru konumlandırılmalıdır.
	● Simetrik ve asimetrik dengeler kurulmalıdır.
	● Farklı yazı karakterleri ya da puntolar kullanılmalıdır.
	● Vurgulanmak istenen bölümler bold veya italik olmalıdır.
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Üç farklı türde gazete alınız ve gazetelerin birinci sayfalarını yan yana sı-
ralayınız. Bu sayfaların, punto kullanımı ve sütunların yerleştirilme şekilleri 
gibi benzer ya da farklı yönlerini aşağıdaki alana yazınız.  Sınıf ortamında 
öğretmeninizle ve arkadaşlarınızla paylaşınız.
....................................................................................................................
....................................................................................................................
....................................................................................................................

2.2.1. Birinci Sayfa Tasarımında Manşetin Önemi 
TDK Güncel Türkçe Sözlük’e göre “gazetelerin ilk sayfasına iri puntolarla konulan 
başlık’’ anlamına gelen manşet, gazete için önemli bir unsurdur.  Manşet olarak 
seçilen haber, oluşan gündeme göre en son veriler baz alınarak belirlenir ve en son 
en deneyimli haberciler tarafından yazılır. Manşet haber, gazete logosunun hemen 
altında yer alır (Görsel 2.18). Manşetten daha önemli ya da aynı derecede önemli 
olan haberleri ayırmak için logonun üst kısmına yazılan habere sürmanşet haber 
denir (Görsel 2.19). 

Zamanla her şeyin değiştiği gibi tasarım anlayışları da değişmiştir. Geçmişte gö-
rülen birinci sayfa tasarımlarındaki yoğunluk zamanla azalmış, tasarım unsuru ön 
plana çıkmıştır. Ayrıca teknoloji ile günlük yaşama giren internetle beraber gaze-
teler de sanal platformlarda yer almıştır. Dijital ortamda yer alan gazetelerin de 
ana sayfaları, bir nevi birinci sayfa niteliği taşımaya başlamış ve tasarımları da bu 
noktada interaktif ve ilgi çekici hâle getirilmiştir.

Görsel 2.18: Manşet uygulamalı birinci sayfa Görsel 2.19: Sürmanşet uygulamalı birinci sayfa
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2.2.2. Birinci Sayfa Taslak Planı Hazırlama
Her tasarımda olduğu gibi gazetelerin birinci sayfaları düzenlenirken önce eskiz 
ya da taslak hazırlanması önemli bir noktadır. Birinci sayfa, gazetede en son 
hazırlanan sayfadır. Gazetenin haber içeriğine göre en önemli haber, manşete 
alınarak hazırlanır. Sonrasında mizanpaj programı açılır. Gazetenin boyutuna 
göre sayfa ölçüsü belirlenip çalışma sayfası açılır. Gazetenin manşet mi yoksa 
sürmanşet mi hazırlanacağına karar verildikten sonra standart ölçüler ve uygula-
malar dikkate alınarak önce gazete logosunun yeri belirlenir (Görsel 2.20, 2.21).

Görsel 2.20: Logo yeri belirleme

 Görsel 2.21: Manşet haber düzenlemesi
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Logonun yeri belirlendikten sonra manşete yerleştirilecek haberin başlığı, başlı-
ğın kaç punto olacağı, yazının fontu ve rengi belirlenir. Manşette kullanılacak ha-
berin fotoğrafı seçilir. Fotoğraf seçimi ve fotoğrafın hangi ölçülerde kullanılacağı 
da haberin dikkat çekme oranını artıracağından bu seçimler dikkatle yapılmalıdır. 
Gazetenin logosu ve manşet haberin yeri belirlendikten sonra diğer haberlerin ve 
görsellerin yeri belirlenir ve yerleştirme işlemine geçilir (Görsel 2.22). 

Görsel 2.22: Birinci sayfa taslağı
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16 Şekil 2.8’in içine birinci (ön) sayfa şablonu çiziniz. 

Şekil 2.8
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Sınıf arkadaşlarınızla paylaşım yaparak çeşitli yayın kuruluşlarının gaze-
telerini alınız. Gazetelerdeki birinci (ön) sayfaları aşağıda verilenler açısın-
dan inceleyiniz. Düzenlemelerle ilgili notlar alarak sınıfta paylaşınız.

•	 Sütunlar ve birleşim şekilleri 
•	 Sayfaların yeri değişmeyen sayfa 
	 numarası, logosu ve tarih gibi unsurları 
•	 Haber başlıkları 
•	 Metinler 
•	 Görseller 
•	 Spotları ve sayfada yerleşimleri
•	 Reklam alanları 
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2.2.3. Birinci Sayfa Şablonuna Metin, Görsel ve Manşetlerin Taslak Plana 	
          Uygun Yerleştirilmesi
Birinci sayfanın düzenlemesi yapılmadan önce burada kullanılacak haber ve görseller bilgisayar-
da bir dosya içinde toplanır. Çalışma sayfasında kullanılacak tüm materyaller bu dosyadan çalış-
ma sayfasına çağrılır. Kullanılacak görseller, görüntü düzenleme programında düzenlenir; baskı 
formatında kaydedilir. Önceden hazırlanan birinci sayfa şablonu mizanpaj programında açılır. Açı-
lan çalışma sayfasına manşetten verilecek haberin başlığı büyük puntolarla yazılır (Görsel 2.23). 

Görsel 2.23: Birinci sayfa taslağı Görsel 2.24: Yazı alanına world sayfası çağırma

Manşet yazıldıktan sonra metin alanları Type Tool ile oluşturulur. File > Place komutuyla haberin 
olduğu world dosyası seçilir. Açılan pecereden Show İmport Options kısmının seçili olmasına 
dikkat edilir. Eğer seçili değilse seçili hâle getirilir ve Aç komutu ile dosya metin alanına çağrılır 
(Görsel 2.24).

Sayfada yer alan metin alanları yerlerine yerleştirildikten sonra haberler için kullanılacak görseller 
de daha önceden Rectangle Frame Tool ile belirlenen yerlerine File > Place komutu ile yerleş-
tirilir (Görsel 2.25, 2.26).

Görsel 2.25: Rectangle Frema Tool

Görsel 2.26: Birinci sayfa tasarımı

Metin ve görsel alanlar yerleştirildikten sonra 
kullanılan programın düzenlenebilir kayıt türü 
seçilerek kaydedilir. Baskı için hazırlanan ça-
lışmalarda mizanpaj programında File > Pac-
kage komutu ile dosyalar paket hâlinde kay-
dedilebilir. 
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GAZETE SAYFASI HAZIRLAMA
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ÖĞRENME BİRİMİ: GAZETE SAYFASI HAZIRLAMA 
UYGULAMA ADI  : Gazetede Birinci (Ön) Sayfa Tasarımı 
AMAÇ		       : Gazetede birinci (ön) sayfa tasarımı hazırlamak. 

Araç Gereç
1.	 Bilgisayar
2.	 Tarayıcı
3.	 Grafik tasarım programları
4.	 İnternet

Aşağıdaki işlem basamaklarını dikkate alarak mizanpaj progra-
mında gazetenin birinci sayfasını düzenleyiniz.   

İşlem Basamakları
1.	 Atölye önlüğünüzü giyiniz; araç gerecinizi, çalışma alanınızı iş 

sağlığı ve güvenliği tedbirlerini alarak özenle hazırlayınız.
2.	 Bilgisayarı çalışmaya hazır hâle getiriniz. 
3.	 Standart gazete sayfası ölçülerinde bir çalışma sayfası açınız.
4.	 Dosyayı bilgisayarda uygun yere, mizanpaj programının kendi 

formatında kaydediniz.
5.	 Sayfada manşet mi yoksa sürmanşet mi kullanacağınıza karar 

veriniz.
6.	 Sayfanıza logo, reklam, tablo ve yaptığınız düzenlemenin ge-

rektirdiği sabit unsurları yerleştiriniz.
7.	 Konunuza uygun haber metinlerini ve görselleri toplayınız.
8.	 Başlık ve metinlerin karakter ve büyüklüklerini özenle belirleyiniz.
9.	 Kullanılacak görselleri teknik açıdan uygun hâle getiriniz.
10.	Haberin yer alacağı alanı belirleyiniz.
11.	 Uygun görsellerle birlikte başlık, spot ve haber metinlerini say-

faya yerleştiriniz.
12.	Çalışmanızı hem paket olarak hem de PDF formatında kayde-

diniz. 
13.	Çalışmanızın A3 boyutlarında çıktısını alarak sayfalarını kontrol 

ediniz. 

 DEĞERLENDİRME
Uygulama çalışmanızın süresi öğretmeniniz tarafından belirlenecektir. 
Çalışmanız, Ek 1’de verilen “Değerlendirme Formu” ve “Kontrol Liste-
si ”ndeki ölçütlere göre değerlendirilecektir. Çalışmanızı yaparken bu 
ölçütleri dikkate alınız. 
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A)  Aşağıda verilen cümlelerin başındaki parantezlere cümleler doğru ise “D”, yanlış ise 	
      “Y” yazınız. 

1.	 (    ) Bir gazetenin diğer gazeteler arasından sıyrılıp tercih edilmesi için sayfa büyüklüğü 	
	       önemlidir.

2.	 (    ) Gazete tasarımında amaç, haberleri önem sırasına göre düzenlemektir.  
3.	 (    ) Gazete sayfasını düzenlerken en iyi yol sayfayı sütunlara bölmektir.
4.	 (    ) Gazete sayfası tasarımlarında genellikle 344 x 525 mm’lik sayfa ölçülerinde 20 sü-	

        tunluk planlar kullanılır.
5.	 (    ) Sayfa düzenlemesinde altı ve üstü çizgili, gölgeli, konturlu biçimlendirmeler kullanıl-	

	       malıdır.
6.	 (    ) Gazete logosunun üstüne yazılan habere sürmanşet denir.

B)  Aşağıda verilen cümlelerde yer alan boşlukları doğru ifadelerle doldurunuz.
7.	 Haber metinlerinin karakter büyüklüğünde en fazla ……………………….. punto tercih 	
	 edilir. 
8.	 Sayfalarda harf ve satır aralıkları …………………………… kullanılır. 
9.	 Gazetede harf aralıkları ……………………….. değerinde kullanılır.
10.	 Fotoğrafı bulunmayan haberleri desteklemek amacıyla ………………………… 	
	 kullanılabilir.
11.	 Görseller basıma uygun çözünürlükte ve ………………………….. modunda hazırlan-	
	 malıdır. 

C)  Aşağıda verilen soruların doğru cevaplarını işaretleyiniz. 
12.	 Aşağıdakilerden hangisi metin ve görsellerin kolay algılanması için kullanılan 	
	 yardımcı elemanlardır? 
	 A)  Nokta, çizgi
	 B)  Tasarım, denge
	 C)  Reklam, ilan, haber
	 D)  Renk, çizgi, çerçeve
	 E)  Haber, renk, kompozisyon  
13.  Aşağıdaki sayfalardan hangisinde yapılan hata büyük mali kayıplara neden olabilir? 
	 A)  Magazin 
	 B)  Spor
	 C)  Ekonomi 
	 D)  Kültür sanat 
	 E)  İlan 

D)  Aşağıda verilen sorunun cevabını noktalı yerlere yazınız.
14. Seri ilan sayfaları düzenlenirken nelere dikkat edilmelidir? Açıklayınız. 
	 ………………………………………………………………………………………………………
	 ………………………………………………………………………………………………………
	 ………………………………………………………………………………………………………
	 ………………………………………………………………………………………………………

ÖLÇME VE DEĞERLENDİRME



81 Yayın Grafiği

EK 1 / KONTROL LİSTESİ
EK 1      ‘‘  ..................................... ‘‘UYGULAMASI DEĞERLENDİRME FORMU            
Yönerge: Uygulama faaliyeti sonunda öğrenci başarısını aşağıdaki ölçütleri dikkate alarak; 1 (GELİŞTİ-
RİLEBİLİR), 2 (ZAYIF), 3 (ORTA), 4 (İYİ), 5 (ÇOK İYİ) şeklinde puanlayayıp form sonundaki değerlendirme 
yönergesine göre  değerlendiriniz.

ÖLÇÜTLER
DERECELER Alınan

Puan1 2 3 4 5

   
 G

iri
ş

Uygulamaya yönelik araç gereci getirmiş.
Konuya ilişkin  ön araştırmalar yapmış.

Konu ile  ilgili özgün eskiz çalışmaları yapmış.

Tasarım ilkelerini eskiz çalışmalarına  uygulamış. 

G
el

iş
m

e Eskiz çalışmasını  mizanpaj programına aktarmış.

Mizanpaj programında uygun menü araçlarını kullanmış. 

Çalışmayı  ilgili bilgisayar  programında amaca uygun 
olarak tamamlamış.

   
  S

on
uç

Çalışmayı uygun  dijital formatta kaydetmiş.

Çalışmanın istenen özelliklere uygun  baskısını almış.

Zamanı planlı ve verimli kullanmış.

Çalışmayı temiz ve düzenli  teslim etmiş.

Atölye ortamını temiz ve düzenli bırakmış.

Toplam Puan
Puanlama Tabloda her ölçütten alınabilecek en yüksek puan 12 x 5 = 60’tır.   

PUAN = [(Genel puan toplamı x 100) / Alınabilecek en yüksek toplam puan] formülü uygula-
narak 100’lük sisteme dönüştürülür.
NOT: Bu puanlama anahtarından 100 üzerinden 70 alırsanız bir sonraki konuya geçebilirsin-
iz. 69 ve altında puan alırsanız ilgili konu tekrar edilmelidir.

KONTROL LİSTESİ UYGULAMA ADI:..........................................
Yönerge: Aşağıdaki gözlenecek davranışlardan öğrencinin kazanabildiği beceriler için EVET kazanamadığı 
beceriler için HAYIR kutucuğunu (X) işaretleyiniz. 

GÖZLENECEK DAVRANIŞLAR EVET HAYIR
Uygulamaya yönelik araç gereci getirmiş.

Konuya ilişkin  ön araştırmalar yapmış.

Konu ile  ilgili özgün eskiz çalışmaları yapmış.

Tasarım ilkelerini eskiz çalışmalarına  uygulamış. 

Eskiz çalışmasını mizanpaj programına aktarmış.

Mizanpaj programında uygun menü araçlarını kullanmış. 

Çalışmayı  amacına uygun ilgili bilgisayar  programında tamamlamış.

Çalışmayı uygun  dijital formatta kaydetmiş.

Çalışmanın istenen özelliklere uygun  baskısını almış.

Zamanı planlı ve verimli kullanmış.

Çalışmayı temiz ve düzenli olarak teslim etmiş.

Atölye ortamını temiz ve düzenli bırakmış.

Değerlendirme 12 ölçütten toplam 2 ve üstü sayıda HAYIR varsa uygulamada BAŞARISIZ olunmuştur. 
Not: Uygulama sonucunu BAŞARISIZ ise, başarısız olduğunuz konulara geri dönüp bu konuları 
tekrar ediniz. BAŞARILI ise, bir sonraki üniteye geçebilirsiniz.
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1. ÖĞRENME BİRİMİ: DERGİ TASARIMI
1. D 2.  Y 3. D 4. Y 5.  D 6. 21 x 29,7 cm 7. Glyphs

8. punto 9. mizanpaj 10. D 11. C 12. D 13. A

14.	 Görüntülerin net olması ilk kuraldır. Kullanılacak görsellerin renk, ışık, resaulation değerleri netlik 
için önemlidir. Kapakta ya da içerikte kullanılacak her görsel renk, ışık ve resaulation bakımından 
düzenlenmelidir. Bu düzenleme ile hem görseller arası hem de genel uyum sağlanmalıdır. Kullanı-
lacak her görselin içerik ve sayfa yapısıyla uyumlu olmasına özen gösterilmelidir.

15.  •      Görsel hiyerarşi oluşturulmalıdır.
•	 Görüntüler ve tipografi arasında denge sağlanmalıdır. 
•	 Arka plan, içerik ve genel ile uyumlu olmalıdır.
•	 Odak noktası oluşturulmalıdır.
•	 Renk, ışık ve kontrastlık değeri canlı ve uyumlu olmalıdır.

2. ÖĞRENME BİRİMİ: GAZETE SAYFASI HAZIRLAMA

1. Y 2. D 3. D 4. Y 5. Y 6. D 7. 9.5 ya da 10.5

8. daraltılarak 9. -3 10.  grafik ve 
illüstrasyonlar

11. CMYK 12. D 13. C

14.	 Seri ilan sayfaları, diğer sayfalardan farklı olarak standart gazete sayfalarında 10 veya 11 sütun 
şeklinde de düzenlenebilir. İlanlar, belirli standartlara göre ve sade verilir. İlan verenin isteklerine 
göre bazı vurgulama seçenekleri olabilir ancak bunlar gazete sayfa düzeninin genel yapısına aykırı 
olmamalıdır. Metin ve başlıklar gazetenin geneline göre daha küçük kullanılır. Package, genellikle 
çalışma bitirildikten sonra yapılır. Matbaaya giden çalışmalar, kontrol edilmek ve baskıya hazırlan-
mak için bilgisayarda açılır ve gerekli işlemler yapıldıktan sonra baskı yapılır. Ancak giden çalış-
malarda fotoğraf vb. eksik ögeler varsa baskı sürecinde sorunlar yaşanır. Bu tarz sorunların önüne 
geçmek için mizanpaj programında yapılan sayfa tasarımlarda kullanılan tüm fotoğraf, illüstrasyon, 
font vb.nin aynı dosyaya toplandığı bir özellik vardır. 

KAYNAKÇA
Gökçin ÇUBUKÇU, İsmail DOĞAN, GAZETE TASARIMLARINDA HİYERARŞİ VE DÜZENİN 
SAĞLANMASI, Cilt: 4, Sayı: 9, Kasım-Aralık / 2019 AnaBritannica, Cilt1, Sayfa 60 ‘Acta’

GÖRSEL KAYNAKÇA

http://kitap.eba.gov.tr/karekod/Kaynak.
php?KOD=2115

Materyalde kullanılan görsel 
kaynakça için bu linke tklayınız.


